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This guide describes how to configure and use webMethods Adapter for Salesforce. It contains
information for administrators and application developerswhowant to interactwith Salesforce.com
to manage Salesforce objects.

To use this guide effectively, you should be familiar with:

The Salesforce objects that you want to manage.

Salesforce.com workflow and workflow configurations.

Terminology and basic operations of your operating system.

Be familiar with the setup and operation of Integration Server Administrator.

The basic concepts and tasks of Software AG Designer.

Document Conventions

DescriptionConvention

Identifies elements on a screen.Bold

Identifies service names and locations in the format folder.subfolder.service, APIs,
Java classes, methods, properties.

Narrowfont

Identifies:Italic

Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Identifies:Monospace font

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the
information inside the curly braces. Do not type the { } symbols.

{ }

Separates two mutually exclusive choices in a syntax line. Type one of these
choices. Do not type the | symbol.

|

Indicates one or more options. Type only the information inside the square
brackets. Do not type the [ ] symbols.

[ ]

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

...
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Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://
documentation.softwareag.com.

In addition, you can also access the cloudproduct documentation via https://www.softwareag.cloud.
Navigate to the desired product and then, depending on your solution, go to “Developer Center”,
“User Center” or “Documentation”.

Product Training

You can find helpful product training material on our Learning Portal at https://
knowledge.softwareag.com.

Tech Community

You can collaborate with Software AG experts on our Tech Community website at https://
techcommunity.softwareag.com. From here you can, for example:

Browse through our vast knowledge base.

Ask questions and find answers in our discussion forums.

Get the latest Software AG news and announcements.

Explore our communities.

Go to our public GitHub andDocker repositories at https://github.com/softwareag and https://
hub.docker.com/u/softwareag and discover additional Software AG resources.

Product Support

Support for Software AG products is provided to licensed customers via our Empower Portal at
https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

Download products, updates and fixes.

Search the Knowledge Center for technical information and tips.

Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.
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Data Protection

SoftwareAGproducts provide functionalitywith respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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About the Adapter

webMethods Adapter for Salesforce is an add-on to webMethods that enables you to interact with
Salesforce.com andDatabase.com. Salesforce.com is a Customer RelationshipManagement (CRM)
solution that is Software as a Service (SaaS), on-demand, andWeb-based. Database.com is a cloud
database managed by Salesforce.com.

Salesforce.com provides Force.com as a computing platform, from which it exposes access to its
CRM data via a Web services API. Salesforce.com publishes a WSDL file to describe the Web
services. Adapter for Salesforce uses the API to interact with Salesforce.com.Using adapter service
templates, you can create adapter services that use the API to perform operations against the
Salesforce.comCRMdata. Your Integration ServerAdministrator clients can create and run services
that use these adapter services to create, query, retrieve, update, and delete CRMdata. For example,
you can use Adapter for Salesforce to synchronize non-Salesforce.com CRM data with CRM data
in Salesforce.com.

Database.com is amultitenant enterprise cloud databasemanaged by Salesforce.com and designed
to store data for mobile, social, web, and desktop applications. Salesforce Developer, Enterprise,
and Unlimited editions use Database.com in the background when performing tasks, such as
creating custom objects, managing security, or importing data using the Force.com platform and
API. However, Salesforce.com and Database.com have different logon credentials. Based on the
logon credentials youuse,Adapter for Salesforce connects to either Salesforce.com, orDatabase.com.

Architecture and Components

Adapter for Salesforce provides a set of user interfaces, services, and templates that enable you to
create integrations with Salesforce.com. The adapter is provided as a single package that must be
installed on Integration Server. For detailed installation instructions and software requirements,
see Installing, Upgrading, and Uninstalling webMethods Adapter for Salesforce.

The followingdiagram shows at a high level how the adapter components connect to Salesforce.com:

Integration Server Administrator . Adapter for Salesforce is installed and runs on Integration
Server.
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WmART Package. The WmART package provides a common framework for webMethods
version 6 and later adapters to use Integration Server's functionality, making Integration Server
the run-time environment for Adapter for Salesforce. The WmART package is installed with
Integration Server and provides logging, transaction management, and error handling for the
adapter and its connections and services.

Adapter for Salesforce . Adapter for Salesforce is delivered as a single package called
WmSalesforceAdapter. The adapter installation includes templates from which all adapter
connections, adapter services, and adapter notifications can be created. The adapter provides:

Integration Server Administrator user interfaces that enable you to configure and manage
adapter connections

Software AG Designer user interfaces that enable you to configure and manage adapter
services and notifications

Java stubs generated from the Partner WSDL version 25 used to channel service requests
from the adapter to Salesforce.com

Adapter Connection Templates. An adapter connection enables Integration Server to connect
to Salesforce.com at run time. Youmust configure an adapter connection before you can create
adapter services or notifications. Adapter for Salesforce provides templates for adapter
connections in Integration ServerAdministrator. The adapter supports two types of connections:
Salesforce.com connections and Salesforce.comOAuth connections. For a detailed description
of adapter connections and usage information, see “Adapter Connections” on page 15.

Adapter Service Templates. An adapter service enables Integration Server to execute Force.com
Web services to interact with Salesforce.com. For example, an adapter service could update
contact records within the Contact Salesforce object. The adapter provides adapter service
templates in Designer. For more information about adapter service templates, see “Adapter
Services” on page 18.

Adapter Polling Notification Templates. Adapter for Salesforce uses polling notifications,
which poll Salesforce.com for data changes in the organization's data using the supported
Data replication APIs, getUpdated() and getDeleted(). For a detailed description of adapter
polling notifications, see “Adapter Polling Notifications” on page 21.

Adapter Listener Template. Using a Salesforce.com OAuth adapter connection, a listener
waits to receive a message from Salesforce.com. When a message appears on a topic that the
listener is subscribed to, Salesforce.com pushes the message to the listener. The listener then
passes the message to a listener notification. You must configure adapter listeners before you
can configure listener notifications. For a detailed description of adapter listeners, see
“Listeners” on page 26.

Adapter Listener Notification Templates. A listener notification works in conjunction with
a listener to process messages in Adapter for Salesforce. When a listener receives a message
from a Salesforce.com topic, the listener passes the message to an enabled listener notification
that you associated with the listener. The listener notification processes the message either
asynchronously or synchronously. For a detailed description of adapter listener notifications,
see “Listener Notifications” on page 27.
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Salesforce.com. Adapter for Salesforce uses the Force.comWeb services API to access
Salesforce.com CRM data. Salesforce.com publishes a Partner WSDL for the Web services
describing the various supported APIs that can be invoked to access the CRM data. For
information about the Salesforce.com components that the adapter requires, see
“Requirements” on page 34.

The following diagram illustrates the use of Adapter for Salesforce and Integration Server in a
typical business process integration.

Adapter Package Management

Adapter for Salesforce is provided in theWmSalesforceAdapter package. Youmanage this package
like any package on Integration Server. Follow these steps to set up and effectivelymanaging your
packages on Integration Server:

Create user-defined packages for your connections, adapter services, and adapter notifications.
See “Managing the Adapter Package” on page 40 for details.
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Understand how package dependencies work so you make the best decisions regarding how
you manage your adapter services and adapter notifications. See “Package Dependency
Requirements and Guidelines” on page 41 for details.

Control which development groups have access to which adapter services and adapter
notifications. See “Controlling Group Access” on page 43 for details.

Understand how clustering, an advanced feature of Integration Server, works to effectively
manage your adapter services and adapter notifications. Formore information, see “Using the
Adapter in a Clustered Environment” on page 44.

Enable and disable packages. Formore information, see “Enabling andDisabling Packages” on
page 41.

Load, reload, and unload packages. For more information, see “Loading, Reloading, and
Unloading Packages” on page 42.

Adapter Connections

You create one ormore connections at design time to use in integrations. The number of connections
you create depends on your integration needs.

Adapter for Salesforce connections contain credentials that Integration Server must supply to
Salesforce.com and Database.com when the adapter invokes Web services that act on the
organization data. You configure connections using Integration Server Administrator. You must
have webMethods administrator privileges to access the administrative screens of the adapter.

Note:
In this section,whenwe talk about an adapter connection to Salesforce.com,we imply an adapter
connection to either Salesforce.com, orDatabase.com. Formore information aboutDatabase.com,
see “About the Adapter” on page 12.

Types of Adapter for Salesforce Connections
The adapter supports two types of connections:

Salesforce.com connection,which connects in a standardway to Saleforce.comorDatabase.com.

Salesforce.com OAuth connection, which uses the OAuth 2.0 authorization framework to
connect to Salesforce.com or Database.com.

The OAuth framework allows secure authentication for accessing a user’s data, without handing
out the user’s credentials (username and password).

When the adapter makes a login request, Salesforce.com sends two parameters as a response for
making all subsequent calls. The parameters depend on the type of adapter connection that you
use.

The following table shows the parameters that Salesforce.com sends for each connection type and
how the adapter connection interacts with the backend.
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Adapter connection interaction with
Salesforce.com

Parameters that Salesforce.com sends
at a login request from adapter

Type of
connection

Salesforce.com enforces a session
timeout limit that invalidates the

Salesforce.com sessionId

serverURL sessionIdwhen a configured limit is
reached. In order to keep theThe adapter connection maintains the

sessionId and serverURL, which are Salesforce.com connection valid, the
adapter monitors the value of therequired for making any other Web
Session Timeout parameter and logsservice calls to Salesforce.com. The
in again before the session times out.sessionId is essential for Salesforce.com
Maintaining the adapter connectionto ensure that the call is from an

authenticated user. ensures that the adapter service does
not fail because of an
INVALID_SESSION_ID error.

Salesforce.com enforces a session
timeout limit that invalidates the

Salesforce.com
OAuth

Id

accessToken accessTokenwhen a configured limit is
reached. In order to keep theThe accessToken is used for making all

subsequent calls. The adapter Salesforce.com OAuth connection
valid, the adapter monitors the valueconnection maintains the accessToken,
of the Session Timeout parameter andwhich is required formaking any other
logs in again before the session timesWeb service calls to Salesforce.com. The
out. Maintaining the adapteraccessToken is essential for
connection ensures that the adapterSalesforce.com to ensure that the call is

from an authenticated user. service does not fail because of an
INVALID_ACCESS_TOKEN error.

For instructions on configuring, viewing, editing, enabling, and disabling Adapter for Salesforce
connections, see Adapter Connections. For information about setting user privileges, see the
webMethods Integration Server Administrator’s Guide for your release. For a list of tasks that you
must do before you can create your connections, see “Before Configuring or Managing Adapter
Connections” on page 56.

Connection Pools
Integration Server includes a connectionmanagement service that dynamicallymanages connections
and connection pools based on configuration settings that you specify for the connection. By
default, connection pooling is enabled for all adapter connections.

A connection pool is a collection of connections with the same set of attributes. Integration Server
maintains connection pools in memory. Connection pools improve performance by enabling
adapter services to reuse open connections instead of opening new connections. Depending on
the type of edition subscribed by the organization, Salesforce.com limits the number ofAPI requests
or calls that any one organizationmay execute concurrently, or within any 24 hour period. Ensure
that you set the Minimum Pool Size and Maximum Pool Size parameters of adapter connection
appropriately. For information about these parameters, see “ConfiguringAdapter Connections” on
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page 56. Formore information onAPI usagemetering, see the Force.comWeb Services APIDeveloper's
Guide.

Run-Time Behavior of Connection Pools

When you enable a connection, Integration Server initializes the connection pool, creating the
number of connection instances you specified in the Minimum Pool Size parameter of the
connection. Whenever an adapter service needs a connection, Integration Server provides a
connection from the pool. If no connections are available in the pool, and the maximum pool size
has not been reached, the server creates one or more new connections (according to the number
specified in Pool Increment Size), and adds them to the connection pool. If the pool is full (as
specified in Maximum Pool Size), the requesting service will wait for Integration Server to obtain
a connection, up to the length of time specified in theBlock Timeout parameter, until a connection
becomes available. Periodically, Integration Server inspects the pool and removes inactive
connections that have exceeded the expiration period that you specified in Expire Timeout.

For information about configuring connections, see Adapter Package Management.

Built-In Services for Connections
Integration Server provides built-in services that enable you to programmatically control
connections. You can use them to enable and disable a connection, and to return usage statistics,
the current state (Enabled or Disabled), and error status for a connection. These services are located
in the WmART package, in the pub.art.connection folder.

The setAdapterServiceNodeConnection built-in service enables you to change the connection associated
with an adapter service. See “Changing the Connection Associated with an Adapter Service at
Design Time” on page 17.

For details about the WmART services, see the webMethods Integration Server Built-In Services
Reference for your release.

Changing the Connection Associated with an Adapter Service
at Design Time
If you want to assign a different connection to an adapter service after you configure the adapter
service, use the setAdapterServiceNodeConnection built-in service, which is located in the WmART
package's pub.art.service folder. This service allows you to change the specific connection associated
with an adapter service at design time so that you do not need to create and maintain multiple
adapter services.

Note:
This built-in service can be run at design time only; do not use it within an Integration Server
flow or Java service. You must run this service directly from Designer by selecting the service
and running it.

For details about the setAdapterServiceNodeConnection service, see the Publish-Subscribe Developer’s
Guide for your release.
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Other built-in services enable you to control connections; for more information, see “Built-In
Services for Connections” on page 17.

Changing the Connection Associated with an Adapter Service
at Run Time
You can dynamically select the connection an adapter service uses to interact with the resource
of the adapter. This feature enables one service to interactwithmultiple, similar back-end resources.

For example, you can configure an adapter service to use a default connection that interacts with
the production Salesforce.comdata. However, at run time, you can override the default connection
and use another connection to interact with the Force.com sandbox for testing.

Alternatively, at run time, you can override the Salesforce.com user credentials configured for
that connection by specifying an alternative user name and password to connect to Salesforce.com.

Formore information about overriding a service's default connection at run time, see “Dynamically
Changing a Service's Connection at Run Time” on page 64.

Adapter Services

To use Adapter for Salesforce, you need to configure adapter services. Adapter services allow you
to connect to the adapter's resource (that is, Salesforce.com) and initiate an operation on the resource
from Integration Server.

You call adapter services from flow or Java services to interact with Salesforce.com. Integration
Server uses adapter connections that you defined earlier to execute the adapter services. The
adapter services invoke Web services in the Force.comWeb services API.

Adapter services are based on templates provided with the adapter. Each template represents a
specific operation you can perform against Salesforce.com CRM data, such as retrieving field
values from records in a Salesforce object.

An adapter service template contains all the code necessary for interacting with Salesforce.com,
butwithout the data specifications. You provide these specificationswhen you create a new adapter
service. To do so, you assign an adapter connection to the service using Designer. Then select the
adapter service template and supply the required data specifications.

For more information about working with services, see the webMethods BPM Task Development
Help for your release.

Adapter Service Templates
Adapter for Salesforce provides the following adapter service templates:
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DescriptionAdapter Service
Template

Handles a large number of records of a Salesforce object. The service
performs the following operations against a batch of Salesforce object
records:

Batch Operation

Inserts new records.

Updates records.

Inserts and updates records.

Deletes records.

Performs a query to find records and return field values from
matching records.

Formore details, see “Configuring BatchOperationAdapter Services” on
page 73.

Inserts new records into one or multiple Salesforce objects. For example,
you might insert new contacts in the Contact Salesforce object, or new

Create Operation

records into both the Contact and Account Salesforce objects. For more
details, see “ConfiguringCreateOperationAdapter Services” on page 75.

Creates a query service that allows you to configure a dynamic Salesforce
Object Query Language (SOQL) statement, part of which you set at run

Custom Query
Operation

time using input fields. Formore details, see “ConfiguringCustomQuery
Operation Adapter Services” on page 77.

Deletes records from the data of the organization. For example, youmight
delete one ormore contacts from the Contacts Salesforce object. Formore
details, see “ConfiguringDelete OperationAdapter Services” on page 81.

Delete Operation

Monitors the status and displays the results of the batch operations
executed by the Batch Operation service. For more details, see
“Configuring Monitor Batch Operations Adapter Services” on page 82.

Monitor Batch
Operations

Executes a query against a Salesforce object to findmatching records and
return field values from those records. For example, you might query

Query Operation

the Contacts Salesforce object to find contacts that have a certain "Title"
and return the values in the FirstName and LastName fields for those
matching contacts. For more details, see “Configuring Query Operation
Adapter Services” on page 84.

Retrieves records of a Salesforce object and returns field values from
those records. You specify the IDs of the records to retrieve. For more

Retrieve Operation

details, see “Configuring Retrieve Operation Adapter Services” on
page 88.
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DescriptionAdapter Service
Template

Updates records of one or multiple Salesforce objects. For example, you
might update Address Information for a contact, or update records in

Update Operation

both the Account and Contact Salesforce objects. For more details, see
“Configuring Update Operation Adapter Services” on page 90.

Either inserts records into or updates records of a Salesforce object. You
specify how to identify the record on which to act. If the record does not
already exist, it is inserted. If the record exists, it is updated.

Upsert Operation

For example, youmight identify a contact by its external ID and provide
information for the contact. If the external ID does not identify an existing
contact, the contact is added; otherwise, the contact with the specified
external ID is updated with the supplied information.

Formore details, see “ConfiguringUpsertOperationAdapter Services” on
page 92.

Invokes one of the following Salesforce.com utilities:Utility Operation

getServerTimestamp. Retrieves the current Salesforce.com system
timestamp.

getSessionId. Obtains a session ID or an access token that you use to
implement custom Salesforce.com operations that the adapter does
not support.

getUserInfo. Obtains personal information about the currently
logged-in user, that is, the user account used for the adapter
connection.

resetPassword. Changes a user's password to a temporary,
system-generated value.

sendEmail. Sends a single e-mail message.

sendMassEmail. Sends multiple e-mail messages.

setPassword. Changes a user's password to a specified value.

Formore details, see “ConfiguringUtilityOperationAdapter Services” on
page 96.

Note:
Making a call to the resetPassword or setPassword utilities changes the credentials of the user,
and will cause any new login requests to fail. Also, any new reset or set password operation
resets the security token. You should update the password field in the connection configuration
with a new password and security token. This security token is not required while testing on
the Salesforce.com sandbox account.
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Adapter Polling Notifications

Adapter for Salesforce supports polling notifications that monitor a specified sObject for changes,
such as an insert, update, or delete operation, so that the appropriate Java or flow services can use
the data for operations such as sending an invoice, or publishing it to Integration Server.

A polling notification periodically checks the resource at specified intervals for the occurrence of
events, and publishes a document each time an event occurs in the resource. For example, your
applicationmight need to be notifiedwhen data is added, updated, and deleted from the resource.
Integration Server invokes the polling notification periodically, based on the polling interval that
you specify when you configure the notification.

Use Designer to configure, edit, and delete polling notifications. All notifications are configured
from a notification template and require a configured connection.

For more information, see Adapter Polling Notifications.

Choice of Publish Destinations
You can choose the destination to which asynchronous polling notifications should publish
messages. Specifically, you can choose whether the asynchronous polling notification templates
use JMS APIs to publish messages to Integration Server or webMethods Broker APIs to publish
notification messages to webMethods Broker.

Note:
To use the JMS protocol with asynchronous polling notifications, you must first configure a
JMS connection alias on Integration Server. Formore information, see thewebMethods Integration
Server Administrator’s Guide for your release.

For steps for selecting a publish destination for asynchronous polling notification messages, see
Adapter Polling Notifications.

Adapter Polling Notification Templates
Adapter for Salesforce provides the following adapter polling notification templates:

DescriptionNotification TemplateNotification Type

Wraps the Force.comWeb service API-
getUpdated() call. Publishes notification of insert
and update operations on a Salesforce object.

UpsertNotificationUpsert Notification

Wraps the Force.comWeb service API-
getDeleted() call.

DeleteNotificationDelete Notification

These polling notifications can be configured only for those Salesforce objects that can be replicable
(that is, the replicateable field for the Object is true). For information about replicating objects, see
the Force.com Web Services API Developer's Guide.
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Polling Notification Types
Adapter for Salesforce provides two types of polling notifications: Upsert and Delete.

Using Upsert and Delete Polling Notifications

The following table lists the tasks required to use these types of polling notification:

Use this tool...Task

Integration Server AdministratorCreate an adapter connection. See “Configuring
Adapter Connections” on page 56 for details.

1

DesignerConfigure the polling notification and specify the
following:

2

Adapter connection.

Salesforce object.

Publishable document to contain the data from
Salesforce.com. There is a single publishable
document used for all events associated with
the notification.

For more details about Integration Server
publishable documents, see thePublish-Subscribe
Developer’s Guide for your release.

Output data fields contained in the publishable
document.

See “ConfiguringAdapter PollingNotifications” on
page 107 for instructions for configuring polling
notifications.

DesignerIf you plan to use an Integration Server flow or Java
service, design it to react to the data changes

3

contained in the polling notification's publishable
document. Create the Integration Server trigger to
use the notification's publishable document. For
details, see thewebMethods Service DevelopmentHelp
for your release.

Integration Server AdministratorSchedule and enable the polling notification.When
you enable the polling notification, the Integration

4

Server Scheduler invokes the notification and
continues to do so periodically, based on the polling
schedule parameters you specify.
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Use this tool...Task

See “Managing Polling Notifications” on page 110
for instruction to schedule and enable notifications.

Designer and Integration Server
Administrator

Manage the polling notification. SeeAdapter Polling
Notifications for details.

5

Upsert and Delete Polling Notifications Processing

The following diagram and steps illustratewhat happenswhen these types of polling notifications
are invoked. Integration Server continues to invoke the notification periodically, as defined when
you configured the polling schedule parameters for the notification.

DescriptionStep

UpsertNotifications andDeleteNotificationsmonitor the organization datamodified
in Salesforce.com. You specified the sObject to bemonitoredwhen you first configured
the adapter polling notification.

1

The polling notification gets a connection from the connection pool of the service.2

Adapter connections contain the connection information for Salesforce.com.

The notification uses the Apache Axis API to connect to Salesforce.com.3

You created and enabled the adapter connection earlier using Integration Server
Administrator.

The polling notification retrieves sObject data from Salesforce.com.4

The polling notification creates the publishable document, which contains data from
Salesforce.com. The notification publishes the publishable document.

5
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DescriptionStep

For more details about Integration Server publishable documents, see the
Publish-Subscribe Developer’s Guide for your release.

Using an Integration Server trigger, you configured to use the notification's publishable
document, a flow or Java service on Integration Server is invoked to react to the data
changes contained in the publishable document.

6

Receiving Outbound Messages from Salesforce.com

Integration Server supports the outboundmessaging feature of Salesforce.com.Using this feature,
you can configure Salesforce.com to sendmessage notificationswhen changes aremade to Salesforce
objects. In certain circumstances, this messaging feature provides advantages over adapter
notifications.

In Salesforce.com, you can configure a workflow rule that defines what changes should trigger a
notification, and indicates that youwant Salesforce.com to send an outboundmessagewhen those
changes occur. For instructions on how to configure Salesforce.com to send outbound message
notifications to your Integration Server, see Salesforce.com Outbound Messaging.

The outboundmessage notifications from Salesforce.com are useful when youwant to specify the
criteria for the notification being sent to Integration Server. Salesforce.com continuously monitors
the designated sObject and sends an outbound message to Integration Server when the specified
field values of the monitored sObject are changed, and the defined workflow rule is executed. In
contrast, adapter polling notifications retrieve only the IDs of the changed records by polling at
configured intervals.

Note that in some cases, adapter polling notifications offer advantages over Salesforce.com
messages. One advantage of using adapter polling notifications is that by specifying the start date
for polling notifications, you have access to data changes made in the past. It is not possible to get
the field values changed in the past using the outbound messages from Salesforce.com. Each
outboundmessage contains information about the data changed in a single record,whereas adapter
polling notifications can retrieve information from multiple records.

To ensure securitywhen receiving outboundmessages from Salesforce.com, place your Integration
Server behind an internal firewall and place a webMethods Enterprise Gateway in the DMZ to
allow it to accept communications and process requests from Salesforce.com.

In an Enterprise Gateway configuration, your Integration Server, which is referred to as the Internal
Server, remains behind your inner firewall where external clients cannot access it. You place
another Integration Server in your DMZ to act as an Enterprise Gateway Server. The Enterprise
Gateway Server acts as an intermediary between the Internet and your Internal Server.

The following diagram illustrates the use of outbound message notifications when using an
Enterprise Gateway Server configuration.
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DescriptionStep

In Salesforce.com, configure a workflow rule to monitor the changes in a Salesforce
object for which you want notification. Configure the workflow rule to send an

1

outbound message when the change occurs. When defining the outbound message,
specify the Enterprise Gateway external port as the endpoint URL.

When Salesforce.comdetects the change, it sends the outboundmessage to the endpoint
URL configured in the workflow rule. Because the Enterprise Gateway Server is

2

configured, the outbound message first goes to the Enterprise Gateway Server. The
Enterprise Gateway Server passes the outbound message to the Internal Server.

The web service descriptor consumes the outbound message. The business logic in
the web service descriptor performs processing to handle the outbound notification
message.

3

In addition to performing processing to handle the notification, the web service
descriptor also sends a SOAP response message back to Salesforce.com. The SOAP
response message first goes to the Enterprise Gateway Server.

4

The Enterprise Gateway Server passes the SOAP response message to Salesforce.com.5

For more information about using an Enterprise Gateway Server, see the webMethods Integration
Server Administrator’s Guide for your release. For more information on setting up an Enterprise
Gateway Server to receive outboundmessages from Salesforce.com, see Salesforce.comOutbound
Messaging.

Adapter Polling and Listener Notifications vs. the Outbound
Message Notification from Salesforce.com
This section lists the differences between the adapter notifications and the outbound message
notification feature of Salesforce.com.
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Outbound Message Notification from
Salesforce.com

Adapter NotificationFunctionality

AvailableAvailable through
listener notifications

Immediate notification

Available only if you are using an Enterprise
Gateway Server.

AvailableSecurity

Not availableAvailableAccess to past data
changes

Not availableAvailableBulk data retrieval

AvailableNot availableConditional notification

Adapter Listeners and Listener Notifications

Adapter for Salesforce provides listeners and listener notifications to perform the following
functions:

Monitor messages

Filter messages

Process messages

Listeners
Using a Salesforce.comOAuth adapter connection, aAdapter for Salesforce listenerwaits to receive
a message from Salesforce.com.When a message appears on a topic that the listener is subscribed
to, Salesforce.com pushes the message to the listener. The listener then passes the message to a
listener notification.

Note:Adapter for Salesforce listeners use only Salesforce.comOAuth adapter connections. They
do not run with normal Adapter for Salesforce connections.

Adapter for Salesforce has single-topic listeners that listen to a single topic.

You never invoke a listener directly from a service or client. Instead, a listener is a real-time process
that you configure, enable, and disable using Integration Server Administrator.

All listeners stop functioning when the package containing the listener node is disabled or
when Integration Server shuts down.

All listeners start functioning when the package containing the listener node is enabled or
when Integration Server restarts.

26 webMethods Adapter for Salesforce Installation and User’s Guide 8.2

1 Overview of webMethods Adapter for Salesforce



Listener Notifications
A listener notification works in conjunction with a listener to process messages in Adapter for
Salesforce. When a listener receives a message from a Salesforce.com topic, the listener passes the
message to an enabled listener notification that you associated with the listener.

Important:
If you do not configure any notificationswith a listener, or if you do not enable any of the already
configured notifications, the message is lost.

Software AG recommends that you always start a listener notification before a listener.

Ideally, you should configure only one notification per listener. If you configure multiple
notifications with the same listener, the listener can pass themessage to any of the notifications.
If you configured multiple notifications with a listener, keep enabled only the notification that
you want to be executed.

The listener notification processes the message either asynchronously or synchronously.

Adapter for Salesforce has two types of listener notifications:

Asynchronous Listener Notifications

Synchronous Listener Notifications

Asynchronous Listener Notifications

When you create an asynchronous listener notification, Adapter for Salesforce creates a publishable
document type. At run time, after the listener receives amessage from the topic, the listener invokes
the asynchronous notification. The asynchronous notification publishes the document created
with the asynchronous notification.

An asynchronous listener notification can publish a document in either of the following ways:

Publish to a JMS queue or topic when Integration Server is connected to a JMS provider.

Publish locally to Integration Serverwhen Integration Server is not connected to a JMSprovider.

To process the message from the topic, you should create an Integration Server trigger that
subscribes to the publishable document type that Adapter for Salesforce created with the
asynchronous listener notification. For more information about using triggers with services, see
the Publish-Subscribe Developer’s Guide for your release.

Note:
To use the JMS protocol with asynchronous listener notifications, you must first configure a
JMS connection alias on Integration Server. Formore information, see thewebMethods Integration
Server Administrator’s Guide for your release.

For the steps for selecting a publish destination for asynchronous listener notification messages,
see “Configuring an Asynchronous Listener Notification” on page 128.
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Synchronous Listener Notifications

When you create a synchronous listener notification, Adapter for Salesforce creates the following
publishable document types:

Request document

Reply document

At run time, the synchronous listener notification invokes a specified adapter service and passes
themessage to the specifiedRequest document. The service returns the Reply document toAdapter
for Salesforce. The listener notification waits until the service has finished processing the message
before it initiates the next service.

Synchronous adapter listener notifications execute flow services and return values from those
services. Integration Server 8.2 supports the following two executionmodes to determine how the
notification executes a flow service and returns output:

Service Invoke mode: When this mode is selected, the adapter notification invokes a flow
service directly and returns values as output from that service.

Publish and Wait mode: When this mode is selected, the adapter notification publishes the
received data either to the local Integration Server or to the webMethods Broker connected to
that Integration Server by converting request documents into publishable documents, and
then waits for a reply. This mode is needed when a synchronous adapter notification is
represented as a receive step in a process model.

For steps for selecting a publish destination for synchronous listener notification messages, see
“Configuring a Synchronous Listener Notification” on page 130.

Listener Notification Templates
Adapter for Salesforce provides the following adapter listener notification templates:

DescriptionListener
Notification

Publishes a document that Integration Server processes asynchronously.
Integration Server does not wait until it has finished processing a document
before processing another document.

Asynchronous
Listener
Notification

Formore information about configuring asynchronous listener notifications,
see “Configuring an Asynchronous Listener Notification” on page 128.

Invokes a service to process the message before receiving the next message.Synchronous
Listener
Notification For more information about configuring synchronous listener notifications,

see “Configuring a Synchronous Listener Notification” on page 130.
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Run-Time Processing of Listeners and Listener Notifications
Run-time processing occurs in listeners and listener notifications in the following scenarios:

Listeners and asynchronous listener notifications

Listeners and synchronous listener notifications

Run-Time Processing of Listeners and Asynchronous Listener Notifications

The following diagram and steps illustrate what happens when a listener receives amessage from
a topic and passes the message to an asynchronous listener notification.

DescriptionStep

When there is activity on the Salesforce object defined in the SOQL for a topic, the
Salesforce.com account checks if there is an active listener for the topic. If an active

1

listener is available, Salesforce.com sends the message (which is the result of executing
the SOQL statement) to the listener.

The listener receives the message from the topic.2

The listener checks if there is an active listener notification associatedwith it. If an active
listener notification is available, the listener passes the message to the notification. If

3

no notification is associatedwith the listener or if all associated notifications are disabled,
the message is lost. If there are multiple notifications associated with the listener, any
one of them (randomly) can get the message.

The asynchronous listener notification publishes a document that will be used by the
Broker or local trigger later.

4

The listener gets the nextmessage from the topic, and the adapter repeats steps 1 through
4.

5
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Run-Time Processing of Listeners and Synchronous Listener Notifications

The following diagram and steps illustrate what happens when a listener receives amessage from
a topic and invokes a synchronous listener notification.

DescriptionStep

When there is activity on the Salesforce object defined in the SOQL for a topic, the
Salesforce.com account checks if there is an active listener for the topic. If an active

1

listener is available, Salesforce.com sends themessage (which is the result of executing
the SOQL statement) to the listener.

The listener receives the message from the topic.2

The listener checks if there is an active listener notification associated with it. If an
active listener notification is available, the listener passes themessage to the notification.

3

If no notification is associated with the listener or if all associated notifications are
disabled, the message is lost. If there are multiple notifications associated with the
listener, any one of them (randomly) can get the message.

The synchronous listener notification creates the following documents:4

Request document. The notification sends the Request document as input to the
service that you selected when you configured the notification.

Reply document. The specified service processes the message and returns the
Reply document to the adapter.

The synchronous listener notification invokes the configured Integration Server service
by passing the request and reply documents as input parameters. The reply document
is not used by the listener notification.

5
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Using Version Control Systems to Manage Adapter Elements

The adapter supports the VersionControl System (VCS) Integration feature provided byDesigner.
When you enable the feature in Integration Server, you can check adapter packages or elements
into and out of your version control system from Designer. For more information about the VCS
Integration feature, see the Configuring the VCS Integration Feature.

Beginning with Integration Server 8.2 SP3, the adapter supports the local service development
feature in Designer. This feature extends the functionality of the VCS Integration feature to check
package elements and their supporting files into and out of a VCS directly from Designer. For
more information about local service development and how it compares to the VCS Integration
feature, see the webMethods Service Development Help.

Infrastructure Data Collector Support

InfrastructureDataCollectormonitors the systemandoperational data associatedwithwebMethods
run-time components such as Integration Servers, Broker Servers, Brokers, and adapters, and
reports the status of these components onOptimize for Infrastructure or other external tools.When
you start monitoring an Integration Server, Infrastructure Data Collector automatically starts
monitoring all ART-based adapters that are installed on Integration Server.

For information about monitored key performance indicators (KPIs) collected for the monitored
adapter components, see the Administering webMethods Optimize for your release.

Viewing the Adapter's Update Level

You can view the list of updates that have been applied to the adapter. The list of updates appears
in the Updates field on the adapter's About page in Integration Server Administrator.

Controlling Pagination

When using the adapter on Integration Server 8.2 and later, you can control the number of items
that are displayed on the adapter Connections screen andNotifications screen. By default, 10 items
are displayed per page. Click Next and Previous to move through the pages, or click a page
number to go directly to a page.

To change the number of items displayed per page, set the watt.art.page.size property and specify
a different number of items.

To set the number of items per page

1. From Integration Server Administrator, click Settings > Extended.

2. Click Edit Extended Settings. In the Extended Settings editor, add or update the
watt.art.page.size property to specify the preferred number of items to display per page. For
example, to display 50 items per page, specify:

watt.art.page.size=50
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3. Click Save Changes. The property appears in the Extended Settings list.

Formore information aboutworkingwith extended configuration settings, see thewebMethods
Integration Server Administrator’s Guide for your release.
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Overview

This chapter explains how to install, upgrade, and uninstall webMethods Adapter for Salesforce
8.2. The instructions use the Software AG Installer and the Software AG Uninstaller wizards. For
complete information about the wizards or other installation methods, or to install other
webMethods products, see the Installing webMethods Products On Premises for your release.

Requirements

For a list of the operating systems and webMethods products supported by the adapter, see the
webMethods Adapters System Requirements , available in the webMethods area of the Software AG
Documentation Web page.

Adapter for Salesforce 8.2 has no hardware requirements beyond those of its host Integration
Server.

The following table lists the Salesforce.com components that are required byAdapter for Salesforce.

CommentComponent

When defining an adapter connection, be sure to specify the endpoint
URL to point to version 25.0.

Salesforce.com Partner
WSDL 25

The default endpoint used by Adapter for Salesforce is:
https://login.salesforce.com/services/Soap/u/25.0

When using an alternate endpoint, like Salesforce.com Sandbox or test
environment, be sure to use version 25.0. Specifying a different version
might give unexpected results.

When defining an adapter connection, you must specify the credentials
of a Salesforce.com user account that the adapter uses when interacting
with Salesforce.com using the Partner WSDL API.

Salesforce.com
API-enabled user
account

Adapter for Salesforce requires that the API feature must be enabled by
the user organization. This feature is enabled by default for Unlimited,
Enterprise, and Developer Editions. Some Professional Edition
organizationsmight also have theAPI enabled. If theAPI Enabled feature
is not available, contact Salesforce.comand ensure that it is enabled before
using this adapter.

When running the adapter on Integration Server 8.2 and later, the adapter
uses the common Integration Server libraries.

Apache Axis 1.4

Installing Adapter for Salesforce 8.2

To install Adapter for Salesforce 8.2
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1. Download Installer from the Empower Product Support Website.

2. If you are installing the adapter on an existing Integration Server, shut down the Integration
Server.

3. Start the Installer wizard.

4. Choose the webMethods release that includes the Integration Server on which to install the
adapter. For example, if you want to install the adapter on Integration Server 8.2, choose the
8.2 release.

5. Specify the installation directory as follows:

If you are installing on an existing Integration Server, specify the webMethods installation
directory that contains the host Integration Server.

If you are installing both the host Integration Server and the adapter, specify the installation
directory to use.

The Installer will install the adapter in the Integration Server_directory \packages directory.

6. In the product selection list, select Adapters > webMethods Adapter 8.2 for Salesforce.

To install documentation for Adapter for Salesforce, on the Documentation panel in Installer,
select Adapter Readmes and Documentation.

Alternatively, you can download the documentation at a later time from the Software AG
Documentation Web page.

7. After the installation completes, close the Installer.

8. Start the host Integration Server.

9. Make sure theWmTomcat package is enabled. For instructions, see thewebMethods Integration
Server Administrator’s Guide for your release.

Upgrading to Adapter for Salesforce 8.2

To upgrade to Adapter for Salesforce 8.2

1. Uninstall the older version of Adapter for Salesforce. For information about how to uninstall
Adapter for Salesforce, see the installation guide for the older Adapter for Salesforce version.

2. Delete the WmSalesforceAdapter package from the Integration Server_directory \packages
directory.
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You should not delete any other packages, such as packages that contain connections, services,
and notifications, even when the packages have a dependency on the WmSalesforceAdapter
package.

3. Install Adapter for Salesforce as described in “InstallingAdapter for Salesforce 8.2” on page 34.

4. Restart Integration Server.

Migrating Adapter Services Created with Adapter for Salesforce
7.1 SP1
The input signatures of the create, update, and upsert adapter services have changed in Adapter
for Salesforce 8.2. For this reason, existing create, update, and upsert services will not work with
version 8.2 of the adapter, unless they are updated.

You use the wm.adapter.wmsalesforce.migration.Service:migrate_711_To_82migration utility service to
migrate create, update, and upsert adapter services created with Adapter for Salesforce 7.1 SP1.
The migration service updates the signatures of the existing create, update, and upsert adapter
services.

The migration service automatically corrects the input pipeline mapping of any dependent flow
services that contain create, update, or upsert adapter services.

The migration service also updates the connections defined in the custom package containing the
create, update, and upsert adapter services, as well as any external connections referred to in the
custom package, by changing the Endpoint URL for the connections to
https://login.salesforce.com/services/Soap/u/25.0. The migration service changes the
connection state to enabled for the connections associated with a create, update, or upsert service.

Note:
If the connection associated with a create, update, or upsert adapter service no longer exists,
the service will not be migrated.

watt.adapter.salesforce.migration.updateEndPointURL. Use this property to change the Endpoint
URL for adapter connection using the migration utility.

When the watt property watt.adapter.salesforce.migration.updateEndPointURL is set to true, the migration
utility service changes the default Endpoint URL for adapter connections to the Partner WSDL
version. When the watt property is set to false, the migration utility service does not change the
Endpoint URL for adapter connections. The default is false.

When the value of the watt property is changed, you must restart Integration Server.

The following table shows the input parameters of the migration service:

DescriptionInput Parameter

The name of the package that contains the create, update, or upsert services
created using Adapter for Salesforce 7.1 SP1.

packageName
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The following table shows the output parameters of the migration service:

DescriptionOutput Parameter

The status is either success or failure, depending on the outcome of the
migration service.

status

Before Migrating Adapter Services

To prepare to migrate adapter services created with Adapter for Salesforce 7.1 SP1

1. Back up the package containing the create, update, and upsert adapter services that you want
to migrate.

2. Make sure that none of the create, update, or upsert services is running, either directly or in a
flow service.

3. Make sure that IS_8.2_SP2_Core_Fix5 or later is installed on the host Integration Server.

Important:
If IS_8.2_SP2_Core_Fix5 or later is not installed on the host Integration Server, themigration
service will not work.

Migrating Adapter Services to Adapter for Salesforce 8.2

To migrate create, update, and upsert adapter services created with Adapter for Salesforce
7.1 SP1

1. Upgrade toAdapter for Salesforce 8.2. For information about the upgrade steps, see “Upgrading
to Adapter for Salesforce 8.2” on page 35.

2. In Designer, run the wm.adapter.wmsalesforce.migration.Service:migrate_711_To_82 service.
For information about the service parameters, see “Migrating Adapter Services Created with
Adapter for Salesforce 7.1 SP1” on page 36.

At the end of the migration, the migration service reloads the custom package containing the
create, update, and upsert adapter services, as well as any packages containing flow services that
were modified during the migration.

If after running the migration service, you still have old adapter connections, you can migrate
them by modifying the Endpoint URL for the connections in Integration Server Administrator to
https://login.salesforce.com/services/Soap/u/25.0.
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Uninstalling Adapter for Salesforce 8.2

To uninstall Adapter for Salesforce 8.2

1. Shut down the host Integration Server. You do not need to shut down any other webMethods
products or applications that are running on your machine.

2. Start Software AG Uninstaller, selecting the webMethods installation directory that contains
the host Integration Server. In the product selection list, select Adapters > webMethods
Adapter 8.2 for Salesforce. You can also choose to uninstall documentation.

3. After Uninstaller completes, restart the host Integration Server.

4. Uninstaller removes all Adapter for Salesforce 8.2-related files that were installed. However,
it does not delete files created after you installed the adapter (for example, user-created or
configuration files), nor does it delete the adapter directory structure. You can go to the
Integration Server_directory \packages directory and delete theWmSalesforceAdapter directory.
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Overview

The following sections describe how to set up andmanage yourwebMethodsAdapter for Salesforce
packages, set up Access Control Lists (ACL), and use the adapter in a clustered environment.

Managing the Adapter Package

Adapter for Salesforce is provided in the WmSalesforceAdapter package. Manage the
WmSalesforceAdapter package the sameway youwouldmanage any Integration Server package.

Define connections, adapter services, and adapter notifications in user-defined packages rather
than in the WmSalesforceAdapter package. Doing so will allow you to manage the package more
easily.

As you create user-defined packages in which to store connections, adapter services, and adapter
notifications, use the package management functionality provided in Designer and set the
user-defined packages to have a dependency on the WmSalesforceAdapter package. That way,
when the WmSalesforceAdapter package loads or reloads, the user-defined packages load
automatically. See the following diagram:

Package management tasks include:

Setting package dependencies (see “Package Dependency Requirements and Guidelines” on
page 41).

“Enabling and Disabling Packages” on page 41.

“Controlling Group Access” on page 43.
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Package Dependency Requirements and Guidelines
This section contains a list of dependency requirements and guidelines for user-defined packages.
For instructions for setting package dependencies, see the webMethods Service Development Help
for your release.

By default, the WmSalesforceAdapter package has a dependency on the WmART package.
Do not change this dependency.

A user-defined package must have a dependency on its associated adapter package,
WmSalesforceAdapter. (TheWmSalesforceAdapter package has a dependency on theWmART
package.)

Package dependencies ensure that at startup Integration Server automatically loads or reloads
all packages in the proper order: theWmART package first, the adapter package next, and the
user-defined packages last. The WmART package is automatically installed when you install
Integration Server. You should not need to manually reload the WmART package.

If the connections and adapter services of an adapter are defined in different packages, then:

A package that contains the connections must have a dependency on the adapter package,
WmSalesforceAdapter.

Packages that contain adapter services must have a dependency on their associated
connection package.

Keep connections for different adapters in separate packages so that you do not create
interdependencies between adapters. If a package contains connections for two different
adapters, and you reload one of the adapter packages, the connections for both adapters will
reload automatically.

Integration Server will not allow you to enable a package if it has a dependency on another
package that is disabled. That is, before you can enable your package, you must enable all
packages on which your package depends. For information about enabling packages, see
“Enabling and Disabling Packages” on page 41.

Integration Server will allow you to disable a package even if another package that is enabled
has a dependency on it. Therefore, youmust manually disable any user-defined packages that
have a dependency on the adapter package before you disable the adapter package.

You can name connections, adapter services, and notifications the same name provided that
they are in different folders and packages.

Enabling and Disabling Packages
All packages are automatically enabled by default. When youwant to temporarily prohibit access
to the elements in a package, disable the package.When you disable a package, the server unloads
all of its elements from memory. Disabling a package prevents Integration Server from loading
that package at startup. A disabled package will remain disabled until you explicitly enable it
using Integration Server Administrator.
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Enabling a Package

To enable a package

1. In Integration Server Administrator, select Packages > Management.

2. Click No in the Enabled column. The server displays a and Yes in the Enabled column.

Note:
Enabling an adapter packagewill not cause its associated user-defined packages to be reloaded.
For information about reloadingpackages, see “Loading, Reloading, andUnloadingPackages” on
page 42.

Important:
Before youmanually enable a user-defined package, youmust first enable its associated adapter
package (WmSalesforceAdapter). Similarly, if your adapter hasmultiple user-defined packages,
and you want to disable some of them, disable the adapter package first. Otherwise, errors will
be issued when you try to access the remaining enabled user-defined packages.

Disabling a Package

To disable a package

1. In Integration Server Administrator, select Packages > Management.

2. Click Yes in the Enabled column for the package that you want to disable. The server issues
a prompt to verify that you want to disable the package. Click OK to disable the package.
When the package is disabled, the server displays No in the Enabled column.

A disabled adapter package will:

Remain disabled until you explicitly enable it using Integration Server Administrator.

Not be listed in Designer.

Loading, Reloading, and Unloading Packages
As described above in “Package Dependency Requirements and Guidelines” on page 41, if
user-defined packages are properly configured with a dependency on the adapter package, at
startup Integration Server automatically loads or reloads all packages in the proper order: the
WmARTpackage first, the adapter package next, and the node packages last. You should not need
to manually reload the WmART package.

Reloading Packages Manually
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Reloading a user-defined package will not cause its associated adapter package to be reloaded.
You can reload adapter packages and user-defined packages from either Integration Server
Administrator (by clicking the Reload icon on the Management window) or from Designer (by
right-clicking the package and selecting the Reload Package option from the menu).

Unloading Packages

At shutdown, Integration Server unloads packages in the reverse order in which it loaded them:
it unloads the node packages first, the adapter package next, and the WmART package last
(assuming the dependencies are correct).

Setting Package Dependencies
If a package requires services in another package, the other packagemust load before the dependent
package can load. Set package dependencies to ensure packages are loaded in the correct order.
For example, any packages you create for Adapter for Salesforce services should identify the
WmSalesforceAdapter package as a package dependency because they require services in the
WmSalesforceAdapter to load first. Use the following guidelines:

Set package dependencies from the adapter service package to the package containing the
connection if you configure a connection in one package and the adapter services in another
package. That is, the package that contains the connection should load before the adapter
service package.

When you set this package dependency, it ensures that if someone disables the connection
package and then re-enables it, the adapter services will reload correctly.

If both the connection and adapter services are in the same package, set this package to have
a dependency on the WmSalesforceAdapter package.

In general, packages containing connections should have a dependency set to the adapter
package itself. That is, the adapter service package should depend on the adapter connection
package, which should depend on the adapter package. Similarly, if the adapter services are
in the same package as the connections, the only dependency that you need to set is between
the adapter connection package and the adapter package.

Formore information about setting package dependencies, see thewebMethods ServiceDevelopment
Help for your release.

Controlling Group Access

To control which development group has access to which adapter services, use access control lists
(ACLs). You can use ACLs to prevent one development group from inadvertently updating the
work of another group, or to allow or deny access to services that are restricted to one group but
not to others.

For general information about assigning and managing ACLs, see the webMethods Service
Development Help for your release.
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Using the Adapter in a Clustered Environment

What is Integration Server Administrator Clustering?
Clustering is an advanced feature of the webMethods product suite that substantially extends the
reliability, availability, and scalability of Integration Server Administrator. Clustering accomplishes
this by providing the infrastructure and tools to deploy multiple Integration Servers as if they
were a single virtual server and to deliver applications that leverage that architecture.

Integration Server 8.2 SP2 and higher supports the caching and clustering functionality provided
by Terracotta. Caching and clustering are configured at the Integration Server level and Adapter
for Salesforce uses the caching mechanism that is enabled on Integration Server. Adapter for
Salesforce does not explicitly implement any clustering or caching beyondwhat is already provided
by Integration Server.

By default, Adapter for Salesforce polling notifications use the Integration Server internal services
in a clusteredmode.However, SoftwareAG recommends that you use Integration Server Scheduler
to execute polling notifications. For information about executing polling notifications using the
Integration Server Scheduler, see “Configuring PollingNotificationsWhen the Adapter Run Time
Uses Integration Server Scheduler” on page 48.

With clustering, you get the following benefits:

Reliability. Unlike a server farm (an independent set of servers), clustering provides the
reliability required for mission-critical applications. Distributed applications must address
network, hardware, and software errors that might produce duplicate (or failed) transactions.
Clustering makes it possible to deliver "exactly once" execution as well as checkpoint/restart
functionality for critical operations.

Availability. Clustering provides virtually uninterrupted availability by deploying applications
on multiple Integration Servers; in the worst case, a server failure produces degraded but not
disrupted service. Without clustering-even with expensive Fault-Tolerant systems-a failure of
the system (hardware, java runtime, or software) may result in unacceptable downtime.

Scalability. Clustering provides horizontal scalability,which allows virtually limitless expansion
of capacity by simply addingmoremachines of the same or similar capacity.Without clustering,
only vertical scalability is possible. That is, increased capacity requirements can only be met
by deploying on larger, more powerful machines, typically housing multiple CPUs.
Salesforce.com enforces a usage metering for calls via its API, in order to balance transaction
loads. This is done by limiting the number of API requests (or calls) that any one organization
may execute concurrently or within any 24-hour period. These limits are based on the type of
edition subscribed by an organization and are against the aggregate of all API calls, and not
on a per user basis. When an organization exceeds the limit, the users may be temporarily
blocked from making additional calls.

For more information about API usage metering by Salesforce.com, see the Force.com Web
Services API Developer's Guide.
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Load balancing is an optimizing feature you usewith clustered Integration Servers. Load balancing
controls how requests are distributed to the servers in the cluster. Youmust use a third-party load
balancer to perform load balancing.

Note:Integration Server clustering redirects HTTP and HTTPS requests, but does not redirect
SMTP requests.

For details on Integration Server clustering, see the webMethods Integration Server Clustering Guide
for your release.

Configuring the Adapter in a Clustered Environment
When you configure Adapter for Salesforce to create adapter services, you must:

Ensure that each Integration Server in the cluster contains an identical set of packages (see
“Replicating Packages to Integration Server Administrators” on page 45).

Enable multiple instances of the same polling notification in your cluster (see “Polling
Notification Support in Integration Server Clusters” on page 48).

Replicating Packages to Integration Server Administrators
Every Integration Server Administrator in the cluster should contain an identical set of packages
that you define usingAdapter for Salesforce; that is, you should replicate theAdapter for Salesforce
services, notifications, and the connections.

To ensure consistency, you create all packages on one server, and replicate them to the other
servers. If you allow different servers to contain different services, you might not derive the full
benefits of clustering. For example, if a client requests a service that resides in only one server,
and that server is unavailable, the request cannot be successfully redirected to another server.

For information about replicatingpackages, see the chapter onmanagingpackages in thewebMethods
Integration Server Administrator’s Guide for your release.

Clustering Considerations and Requirements

Note:
The following sections assume that you have already configured the Integration Server
Administrator cluster. For details about webMethods clustering, see the webMethods Integration
Server Clustering Guide for your release.

The following considerations and requirements apply to Adapter for Salesforce in a clustered
environment.

Requirements for Each Integration Server in a Cluster

The following table describes the requirements of each Integration Server in a given cluster:
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For Example...All Integration Servers in a given cluster must have
identical...

One Integration Server in the cluster
cannot be version 8.2 and another

Integration Server versions

Integration Server in the cluster be
version 8.0.

All adapter packages on one
Integration Server should be replicated

Adapter packages

to all other Integration Servers in the
cluster.

All Integration Servers in the cluster
must have the same version of the

Adapter versions

adapter, with the same fixes (updates
and service packs) applied.

With Salesforce.com there is no
physical connection. A Adapter for

Adapter connections

Salesforce connection simplymaintains
the session binding details.

If you plan to use connection pools in
a clustered environment, see
“Considerations When Configuring
Connections with Connection Pooling
Enabled” on page 47.

If you configure a specific adapter
service, this same adapter servicemust

Adapter services

appear on all servers in the cluster so
that any Integration Server in the
cluster can handle the request
identically.

If you allow different Integration
Servers to contain different services,
you might not derive the full benefits
of clustering. For example, if a client
requests a service that resides on only
one server, and that server is
unavailable, the request cannot be
successfully redirected to another
server.

If you configure a specific adapter
notification, this same adapter

Adapter notifications

notificationmust appear on all servers
in the cluster.
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For Example...All Integration Servers in a given cluster must have
identical...

Important:
WhenAdapter for Salesforce listener
notifications subscribed to the same
push topic are enabled on all nodes
in an Integration Server cluster, the
notifications receive duplicate
messages from the topic. To avoid
duplicate messages, Software AG
recommends that you keep a listener
notification enabled only on one of
the Integration Server nodes in a
cluster for each push topic.

For more information about adapter
notifications in a cluster, see “Polling
Notification Support in Integration
Server Clusters” on page 48 and
“Listener Notification Support in
Integration Server Clusters” on
page 54.

See “Replicating Packages to Integration Server Administrators” on page 45 for information about
replicating adapter packages, connections, and adapter services acrossmultiple Integration Servers
in a cluster.

Considerations When Installing Adapter for Salesforce Packages

For each Integration Server in the cluster, use the standard Adapter for Salesforce installation
procedures for each machine, as described Installing, Upgrading, and Uninstalling webMethods
Adapter for Salesforce.

Considerations When Configuring Connections with Connection Pooling Enabled

With Salesforce.com there is no physical connection. A Adapter for Salesforce connection simply
maintains the session binding details. However, there are restrictions imposed by Salesforce.com
for concurrent API access. For information about API usage monitoring, see the Force.com Web
Services API Developer's Guide.

For information about configuring connections for the Adapter for Salesforce, see “Configuring
Adapter Connections” on page 56.

For more general information about connection pools, see the webMethods Integration Server
Administrator’s Guide for your release.
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Polling Notification Support in Integration Server Clusters
Adapter for Salesforce enables the coordinated execution of polling notificationswithin a Integration
ServerAdministrator cluster. Adapter for Salesforce provides the ability to enablemultiple instances
of the same polling notification in your cluster, and to coordinate their schedules and execution.
This provides enhanced quality of service by allowing configurations for automated failover
between notifications and distributed processing of polling notifications.

Configuring Polling Notifications When the Adapter Run Time Uses Integration
Server Scheduler

Adapter for Salesforce uses Integration Server Administrator Scheduler to support polling
notifications. On enabling a polling notification, a new Integration Server scheduled task is created,
which polls the backend resource at the given interval. Do not manually edit or change scheduled
tasks. Each polling notification creates an Integration Server scheduled task. When a notification
is disabled, the scheduled task in Integration Server is removed.

Before Configuring Polling Notifications to Execute via Scheduled Tasks

Before configuring your existing polling notifications to execute via scheduled tasks, ensure that:

All polling notifications for which you want to use scheduled task functionality are disabled.

Note:
Enabling or disabling the polling notification node on one Integration Server node in the
cluster will enable or disable the polling notification node on all Integration Server nodes
in the cluster.

For instructions on disabling polling notifications, see “Managing Polling Notifications” on
page 110.

Each notification is present in all cluster nodes at all times.

The Overlap function for the polling notifications is disabled.

Polling notifications names do not exceed 400 characters.

The value of the Integration Server watt.server.scheduler.threadThrottle property should not
be lower than the number of total polling notifications and scheduled tasks. By default the
value is 75% of the total threads.

The IS Internal functional alias (specified on the Settings > JDBC Pools screen) is configured
with a database.

Configuring Polling Notifications to Execute via Scheduled Tasks

To configure polling Notifications to execute via scheduled tasks

1. Start Integration Server and log into Integration Server Administrator.
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2. From Integration ServerAdministrator, selectSettings > Extended > Edit Extended Settings.

3. Enable the use of scheduled tasks for polling notifications by setting
watt.pkg.art.pollingnotification.scheduler=true

If the parameter is not shown, add it.

4. Specify the adapter package in the watt.pkg.art.pollingnotification.scheduler.adapters
parameter: watt.pkg.art.pollingnotification.scheduler.adapters=WmSalesforceAdapter

If the parameter is not shown, add it.

5. Make scheduled notification tasks visible in the Server > Scheduler page by setting
watt.server.scheduler.notificationtask.display=true

If the parameter is not shown, add it.

Note:
Configuring this property is required only for debugging or for editing the polling notification
schedule interval.

6. Click Save Changes.

Keys for the new parameters appear in the Extended Settings.

7. Restart Integration Server.

8. Enable all polling notifications. For instructions, see “Managing Polling Notifications” on
page 110.

Configuring Polling Notifications in Standby or Distributed Mode

You can configure a polling notification to run in either Standby or Distributed mode. You can
also configure additional settings for clustered polling notifications.

Standby Mode and Distributed Mode

In Standby mode, a particular instance of a polling notification will execute the notification
according to its configured schedule. When you start the cluster, the polling notification that
executes the first scheduled run is considered to be the primary notification. This instance will
continue to execute the scheduled run as long as it is enabled and fully functional. If at any time
this notification becomes disabled, another notification in the cluster will assume control. The
notification that assumes control is arbitrary. After a notification has control, it will continue to
execute the schedule for as long as it is enabled and fully functional.

In Distributed mode, any instance of the polling notification can execute the currently scheduled
run. The notification that executes the current scheduled run is arbitrary. If a notification does not
complete executingwithin the amount of time specified in theMax Process Time field, the system
considers that notification to be "dead." (For details about Max Process Time, see
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Notification-Specific Settings in “Settings” on page 50.) Another (enabled) instance in the cluster
will recognize this situation and will attempt to execute the scheduled run.

Settings

All settings that pertain to clustered polling notifications are ignored or disabled until you include
the server in a cluster. All settings have default values. There are three levels of settings:

Server-Wide Settings. The server-wide settings are common to all webMethods 6.x and later
adapters running on Integration Server. The server uses the settings in an algorithm that
determines whether a polling notification instance should be considered "dead." For more
information, see the webMethods Integration Server Clustering Guide for your release.

Values and DescriptionServer-wide Setting Name

An integer value specifying the
frequency (in milliseconds) at which

watt.art.clusteredPollingNotification.
keepAliveInterval

a notification instance tells the cluster
it is still alive.

An integer value specifying the
number of milliseconds that a

watt.art.clusteredPollingNotification.
keepAliveExpireTimeout

keepAliveInterval setting can be late
before it is assumed that an instance
has failed. Default: The value of
keepAliveInterval.

Note:
You should allow for "clock drift."
For details, see “Clock
Synchronization” on page 53.

Adapter-Specific Settings. The adapter-specific settings apply to all the polling notifications
in your Adapter for Salesforce.

Adapter for Salesforce generates a configuration file for your polling notification templates.
This file, WmSalesforceAdapter\config\clusterProperties.cnf, is an XML file that contains a
pair of settings (callbackScheme and runtimeModeLimit) for eachpolling notification template
defined in your adapter. For example, if you created notifications using the notification
templates UpsertNotification and DeleteNotification, you will see these settings for each
template. For an example file, see the example Adapter for Salesforce clusterProperties.cnf file
following the table.

The available values for these settings are as follows:
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Values and DescriptionAdapter-specific
Setting Name

Specifies the run-time operations the adapter should handle for the
notifications, such as enabling and disabling the notifications.

callbackScheme

0: No callback coordination.

1: Default. Coordinates the enable and disable operations.

2: Coordinates the startup and shutdown operations.

3: Coordinates the enable, disable, startup, and shutdownoperations.

Important:
This value must always be 1 for Adapter for Salesforce.

Specifies the schedulingmode for the notifications. The value you assign
to this setting determines which modes the adapter users may select in

runtimeModeLimit

the Coordination Mode field on the Polling Notification Schedule page
(see Notification-Specific Settings in “Settings” on page 50).

disable: Prevents the adapter user from selecting Standby or
Distribute modes on the adapter's Polling Notification Schedule
page.

standby: Default. Enables the adapter user to select either theDisable
mode or the Standby mode.

distribute: Enables the adapter user to select either the Disable,
Standby or Distribute mode.

For more information, see “Standby Mode and Distributed Mode” on
page 49.

Example Adapter for Salesforce clusterProperties.cnf File

The following example clusterProperties.cnf file for Adapter for Salesforce shows the entries
for all the possible templates associated with Adapter for Salesforce polling notifications. This
example file enables all notifications to be configured with the Coordination Mode field set
to distribute.
<?xml version="1.0"?>

<clusterProps>

<pollingNotifications>

<callbackScheme>1</callbackScheme>

<runtimeModeLimit>distribute</runtimeMo deLimit> <template
className="com.w m.adapter.wmsalesforce.notification.DeleteNotificatio n">

<callb ackScheme>1</callbackScheme>
<runtimeModeLimit>distribute</runtimeModeLimit>
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< /template>
<template className="com.w

m.adapter.wmsalesforce.notification.UpsertNotificatio n">
<callb ackScheme>1</callbackSche me>
<runtimeModeLimi t>distribute</runtimeModeLimit>

</t emplate>
</pollingNotific ations>
<lis tenerNotifications>
<callbackScheme>1</callbackS cheme>

</list enerNotifications>
<listeners>
<runtimeModeLimit>distribute</runtimeModeLimit>

</listeners>
</clusterProps>

Notification-Specific Settings.The notification-specific settings enable you to configure certain
scheduling aspects of polling notifications on an individual basis.

Two new fields appear on the Polling Notification Schedule page: Coordination Mode and
Max Process Time. These fields become editable when you add your Integration Server to a
cluster.

TheCoordination Mode field controls the coordination of the notification schedules across
the cluster. Depending on the value you assigned to the runtimeModeLimit setting (see
Adapter-Specific Settings in “Settings” on page 50), the adapter user can select some
combination of the following values in the Coordination Mode field as follows:

Displays these values in the Coordination Mode
field...

This runtimeModeLimit value...

disabledisable

disable and standbystandby

disable, standby, and distributedistribute

The Max Process Time field enables other notifications to determine whether a currently
executing notification should be considered to be "dead." If a notification executes a
scheduled run and it fails to complete before the Max Process Time, then another
notification instance will consider it dead; this other notification will assume control and
execute a scheduled run. The default value is equal to the value in the
watt.art.clusteredPollingNotification.keepAliveExpireTimeout setting in the server.cnf
file.

If the Max Process Time setting is not high enough, you may encounter a situation in
which a notification is executing normally but another notification assumes it is "dead."
When the original notification completes, it will recognize that it was prematurely
considered "dead." In this case, the system logs an Illegal Overlap exception with message
id [ART.116.3715]. If this exception occurs, increase your Max Process Time setting.

When setting the value ofMax Process Time, you should allow for "clock drift." For details,
see “Clock Synchronization” on page 53.
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If you want to update the schedule and settings of a notification in a cluster, all notification
instances in the cluster must be suspended or disabled for the changes to be saved. If any
notification instance in the cluster is enabled, the adapter will not save the updates.

If all instances of a notification in the cluster do not have the same settings, the notification
that became active first will have precedence.

Clock Synchronization

To determine whether a notification has failed, notifications use the system clocks of themachines
that host the clustered Integration Servers. Synchronizing the clocks of all machines in the cluster
is critical for the proper execution of clustered polling notifications.

However, in time these clocks might become un-synchronized. Therefore you should anticipate
the effect of "clock drift"when you establish values for the keepAliveExpireTimeout server-specific
setting and Max Process Time notification-specific setting. Clock drift is the time difference
between the clocks. As a guideline, add to the keepAliveExpireTimeoutand the Max Process
Time settings two times the maximum clock drift you anticipate.

Configuring Adapter Notification Schedules in a Clustered Environment

To enable Adapter for Salesforce polling notifications to distribute or standby mode

1. In the cluster, shut down the Integration Server you are configuring.

2. Open the WmSalesforceAdapter\config\clusterProperties.cnf file.

3. Change all <runtimeModeLimit> value to <distribute> or <standby>. To see a sample
clusterProperties.cnf file, see Adapter-Specific Settings in “Settings” on page 50.

4. Save the file and restart Integration Server.

5. Start Integration Server Administrator.

6. Select Adapters > Adapter 8.2 for Salesforce.

7. From the navigation area, select Polling Notifications.

8. For each notification:

a. Disable the notification.

b. Click the Edit Schedule icon.

c. Set theCoordination Mode toDistributed orStandby (as appropriate for the notification).

d. Enable the notification.
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Important:
Tomaintain duplicate detection and ordering, your polling notification schedules must not run
with the Overlap option selected. (To access the Overlap option, click the Edit Schedule icon.)

After you configure a polling notification, you may propagate all the affected components across
your cluster. Changing the polling notification schedule from Integration Server Administrator
or changing the polling notification settings in Designer will require you to propagate the polling
notification across the cluster. If you made changes to the settings in server.cnf or to the
WmSalesforceAdapter\config\clusterProperties.cnf files, you must also propagate these across
the cluster.

Listener Notification Support in Integration Server Clusters
Adapter for Salesforce listener notifications subscribed to the same push topic receive duplicate
messages when the notifications are enabled on all nodes in an Integration Server cluster.
Salesforce.com sends notifications to all the clients subscribed to a push topic. Each listener
notification in a cluster makes an independent connection to the push topic and all listener
notifications get notified of the same event. Thus the listener notifications in an Integration Server
cluster will be triggered multiple times (as many times as the number of Integration Servers in
the cluster) for the same event on the push topic.

To avoid creating duplicatemessages, SoftwareAG recommends that you keep a particular listener
and its associated listener notification(s) enabled only on one of the Integration Server nodes in a
cluster for each push topic.
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Overview

This chapter describes how to configure andmanageAdapter for Salesforce connections. Formore
information about how adapter connections work, see “Adapter Connections” on page 15.

For instructions on how to configure the proxy servers, see the webMethods Integration Server
Administrator’s Guide for your release.

Before Configuring or Managing Adapter Connections

To prepare to configure or manage an adapter connection

1. Install Integration Server Administrator and Adapter for Salesforce on the same machine. For
details, see Installing, Upgrading, and Uninstalling webMethods Adapter for Salesforce.

2. Make sure you have webMethods administrator privileges so that you can access Adapter for
Salesforce's administrative screens. For information about setting user privileges, see the
webMethods Integration Server Administrator’s Guide for your release.

3. Start Integration Server and Integration Server Administrator, if they are not already running.

4. Using Integration Server Administrator, make sure the WmSalesforceAdapter package is
enabled. See “Enabling Adapter Connections” on page 67 for instructions.

5. Using Software AG Designer, create a user-defined package to contain connections, if you
have not already done so. See “Managing the Adapter Package” on page 40 for details.

6. Create your connections, as described in “Configuring Adapter Connections” on page 56.

Configuring Adapter Connections

When you configure Adapter for Salesforce connections, you specify information that Integration
Server uses to connect to Salesforce.comandDatabase.com.Using Integration ServerAdministrator,
you can configure two types ofAdapter for Salesforce connections: Salesforce.comor Salesforce.com
OAuth.

Adapter for Salesforce connections can useHTTP/HTTPS proxy servers registeredwith Integration
Server to connect to Salesforce.com. To enable the proxy settings, in Integration Server
Administrator, set the watt.adapter.salesforce.useproxy watt property to true. By default, the
property is set to false. If the watt property is set to true, a Adapter for Salesforce connection
automatically uses the default proxy server registered with Integration Server, provided that the
proxy server is enabled. If you change the proxy server settings in the Integration Server
configurationparameters, restart Integration Server because the settings are cached at the Integration
Server level.

For information about configuring the watt.adapter.salesforce.useproxy watt property, see the
webMethods Integration Server Administrator’s Guide for your release.
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Note:
In this section,whenwe talk about an adapter connection to Salesforce.com,we imply an adapter
connection to either Salesforce.com, orDatabase.com. Formore information aboutDatabase.com,
see “About the Adapter” on page 12.

Configuring a Salesforce.com Connection

To configure a Salesforce.com connection

1. In Integration Server Administrator, select Adapters> Adapter for Salesforce.

2. On the Connections screen, select Configure New Connection.

3. On the Connection Types screen, selectSalesforce.com Connection to display the Configure
Connection Type screen.

4. In the Configure Connection Type > Adapter for Salesforce section, provide values for the
following parameters:

DescriptionParameter

The package in which to create the connection.Package

You must create the package using Designer before you can specify it
using this parameter. For general information about creating packages,
see the webMethods Service Development Help for your release.

Note:
Create the connection in a user-defined package rather than in the
WmSalesforceAdapter package. See “Managing the Adapter
Package” on page 40 for other important considerationswhen creating
packages for Adapter for Salesforce.

The folder in which to create the connection.Folder Name

The name you want to give the connection. Connection names cannot
have spaces or use special characters reserved by Integration Server and
Designer.

Connection Name

For more information about the use of special characters in package,
folder, and element names, see thewebMethods Service Development Help
for your release.

5. In the Connection Properties section, provide values for the following parameters:
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DescriptionParameter

Defines the login endpoint for initiating communications with
Salesforce.com. The default URL for the WSDL version 25 is:

Endpoint URL

https://login.salesforce.com/services/Soap/u/25.0

Adapter for Salesforce enables users to specify an alternate URL when
using the Salesforce.com Sandbox or a testing environment.

To access the organization's Salesforce.comsandbox, specify the following
URL:
https://test.salesforce.com/services/Soap/u/25.0

Identifies the user name for the Salesforce.com or Database.com user
account that you want the adapter to access. Typically, the user name is
an e-mail address.

User Name

Identifies the password associated with User Name and the user's
security token. For example, if the password is "mypassword" and the

Password

Retype Password security token is "XXXXXXXXXX", specify the following for Password
and Retype Password:
mypasswordXXXXXXXXXX

Salesforce.com or Database.com require a security token for access via
the Force.comWeb service API. To obtain the security token from the
Salesforce.com or Database.com user interface, select Setup; then in the
My Personal Information section of the screen, click Reset your
security token. Salesforce.com resets the security token and sends an
e-mail message with the new security token to the registered user.

Note:
The security token you specify in the connection is valid until you
reset it, change your password, or have your password reset. The
security token is not required, if the endpoint URL is a Salesforce.com
sandbox.

Defines the number of seconds that Adapter for Salesforce waits for a
response from Salesforce.com before reporting a connection timeout.

Connector Timeout
(sec)

This is a SOAP connection timeout. The default is 60 seconds. The adapter
expects a positive integer value. A value of 0 means no timeout.

Defines the number ofminutes tomaintain a Salesforce.comuser session
before performing a re-login to keep the session alive. The default is 30
minutes.

Session Timeout
(min)

Specify the same value here as in the Security Controls setup area in the
Salesforce.com user interface, to allow the adapter to automatically
re-login to prevent a session from expiring. After a session is established,
Salesforce.com automatically expires the session after the number of
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DescriptionParameter

minutes specified in the SecurityControls setup area in the Salesforce.com
user interface.

Indicates whether you want the adapter to enable compression in the
SOAP request and response messages sent to Salesforce.com.

Use Compression

Select false to disable compression. This is the default.

Select true to enable compression.

As defined by the HTTP 1.1 specification to indicate that compression
is supported, the adapter includes "Accept-Encoding: gzip, deflate" in
the HTTP header of the request message.

For compressed response messages, the HTTP header includes
"Content-Encoding: deflate" or "Content-Encoding: gzip", as appropriate.

6. In the Connection Management Properties section, provide values for the following
parameters:

DescriptionParameter

Enables the adapter to use connection pooling. The default is true.Enable Connection
Pooling

See “Connection Pools” on page 16 for more information about
connection pooling in the adapter.

If you plan to enable connection pooling in a clustered environment,
consider the connection pool size. For details, see “Considerations
WhenConfiguringConnectionswithConnectionPoolingEnabled” on
page 47.

The minimum number of connection objects that remain in the
connection pool at all times. When the adapter creates the pool, it
creates this number of connections. The default is 1.

Minimum Pool Size

The maximum number of connection objects that can exist in the
connection pool.When the connection pool has reached itsmaximum

Maximum Pool Size

number of connections, the adapterwill reuse any inactive connections
in the pool or, if all connections are active, it will wait for a connection
to become available. The default is 10.

If connection pooling is enabled, this parameter specifies the number
of connections by which the pool will be incremented if connections
are needed, up to the maximum pool size. The default is 1.

Pool Increment Size

If connection pooling is enabled, this parameter specifies the number
ofmilliseconds that Integration Serverwill wait to obtain a connection
before it times out and returns an error. The default is 1000.

Block Timeout (msec)
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DescriptionParameter

If connection pooling is enabled, this parameter specifies the number
of milliseconds that an inactive connection can remain in the pool

Expire Timeout
(msec)

before it is closed and removed from the pool. For example, to specify
10 seconds, specify 10000. Enter 0 to specify no timeout. The default
is 1000.

Note:
The adapter will never violate the Minimum Pool Size parameter.
These connections remain in the pool regardless of how long they
are inactive.

If connection pooling is enabled, this parameter specifies the number
of times that the system should attempt to initialize the connection

Startup Retry Count

pool at startup if the initial attempt fails, before issuing an
AdapterConnectionException. The default is 0.

If connection pooling is enabled, this parameter specifies the number
of seconds to wait between each attempt to initialize the connection
pool. The default is 10.

Startup Backoff
Timeout (sec)

7. Click Save Connection.

The connection you created appears on the adapter's Connections screen.

8. Be sure to enable the connection before you create adapter services that use it. See “Enabling
Adapter Connections” on page 67 for instructions.

Configuring a Salesforce.com OAuth Connection

To configure a Salesforce.com OAuth connection

1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. On the Connections screen, select Configure New Connection.

3. On theConnectionTypes screen, selectSalesforce OAuth Connection to display theConfigure
Connection Type screen.

4. In the Configure Connection Type>Adapter for Salesforce section, provide values for the
following parameters:

DescriptionParameter

The package in which to create the connection.Package
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You must create the package using Designer before you can specify it
using this parameter. For general information about creating packages,
see the webMethods Service Development Help for your release.

Note:
Create the connection in a user-defined package rather than in the
WmSalesforceAdapter package. See “Managing the Adapter
Package” on page 40 for other important considerationswhen creating
packages for Adapter for Salesforce.

The folder in which to create the connection.Folder Name

The name you want to give the connection. Connection names cannot
have spaces or use special characters reserved by Integration Server and
Designer.

Connection Name

For more information about the use of special characters in package,
folder, and element names, see thewebMethods Service Development Help
for your release.

5. In the Connection Properties section, provide values for the following parameters:

DescriptionParameter

Defines the login endpoint for initiating communications with
Salesforce.com using the OAuth 2.0 framework. The default URL is:

Login Endpoint
URL

https://login.salesforce.com/services/oauth2/token

Identifies the user name for the Salesforce.com or Database.com user
account that you want the adapter to access. Typically, the user name is
an e-mail address.

User Name

Identifies the password associated with User Name and the user's
security token. For example, if the password is "mypassword" and the

Password

Retype Password security token is "XXXXXXXXXX", specify the following for Password
and Retype Password:
mypasswordXXXXXXXXXX

Salesforce.com or Database.com require a security token for access via
the Force.comWeb service API. To obtain the security token from the
Salesforce.com or Database.com user interface, select Setup; then in the
My Personal Information section of the screen, click Reset your
security token. Salesforce.com resets the security token and sends an
e-mail message with the new security token to the registered user.

Note:
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The security token you specify in the connection is valid until you
reset it, change your password, or have your password reset. The
security token is not required, if the endpoint URL is a Salesforce.com
sandbox.

The version of the Salesforce.com Partner WSDL. The connection will
pick this parameter from the partner jar file in the

WSDL Version

Integration Server_directory\packages\WmSalesforceAdapter\code\jars
directory.

In Salesforce.com, your application's client identifier (also known as
consumer key).

Client ID

To obtain the client ID, in the Force.com administration console, go to
Setup > Develop > Remote Access, and click New to create a new
remote access application. After saving the remote access application,
you obtain the new credentials for the client ID.

To create the remote access application, provide values for the following
parameters at Salesforce.com:

Application. The remote access application name.

Contact Email. A valid email ID.

Callback URL. The callback URL is the same as your application’s
callback URL. The URL must begin with https://.

Note:
The callback URL is an OAuth parameter. It is not used by the
adapter. However, the OAuth framework client libraries expect
this parameter.

In Salesforce.com, your application's client secret (also known as
consumer secret).

Client Secret

Confirm the client secret by retyping it.Retype Client
Secret

Defines the number of seconds that Adapter for Salesforce waits for a
response from Salesforce.com before reporting a connection timeout.

Connector Timeout
(sec)

This is an HTTP connection timeout. The default is 60 seconds. The
adapter expects a positive integer value. A value of 0 means no timeout.

Defines the number ofminutes tomaintain a Salesforce.comuser session
before performing a re-login to keep the session alive. The default is 30
minutes.

Session Timeout
(min)
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Specify the same value here as in the Security Controls setup area in the
Salesforce.com user interface, to allow the adapter to automatically
re-login to prevent a session from expiring. After a session is established,
Salesforce.com automatically expires the session after the number of
minutes specified in the SecurityControls setup area in the Salesforce.com
user interface.

6. In the Connection Management Properties section, provide values for the following
parameters:

DescriptionParameter

Enables the adapter to use connection pooling. The default is true.Enable Connection
Pooling

See “Connection Pools” on page 16 for more information about
connection pooling in the adapter.

If you plan to enable connection pooling in a clustered environment,
consider the connection pool size. For details, see “Considerations
WhenConfiguringConnectionswithConnectionPoolingEnabled” on
page 47.

The minimum number of connection objects that remain in the
connection pool at all times. When the adapter creates the pool, it
creates this number of connections. The default is 1.

Minimum Pool Size

The maximum number of connection objects that can exist in the
connection pool. When the connection pool reaches its maximum

Maximum Pool Size

number of connections, the adapterwill reuse any inactive connections
in the pool or, if all connections are active, it will wait for a connection
to become available. The default is 10.

If connection pooling is enabled, this parameter specifies the number
of connections by which the pool will be incremented if connections
are needed, up to the maximum pool size. The default is 1.

Pool Increment Size

If connection pooling is enabled, this parameter specifies the number
ofmilliseconds that Integration Serverwill wait to obtain a connection
before it times out and returns an error. The default is 1000.

Block Timeout (msec)

If connection pooling is enabled, this parameter specifies the number
of milliseconds that an inactive connection can remain in the pool

Expire Timeout
(msec)

before it is closed and removed from the pool. For example, to specify
10 seconds, specify 10000. Enter 0 to specify no timeout. The default
is 1000.

Note:
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The adapter will never violate the Minimum Pool Size parameter.
These connections remain in the pool regardless of how long they
are inactive.

If connection pooling is enabled, this parameter specifies the number
of times that the system should attempt to initialize the connection

Startup Retry Count

pool at startup if the initial attempt fails, before issuing an
AdapterConnectionException. The default is 0.

If connection pooling is enabled, this parameter specifies the number
of seconds to wait between each attempt to initialize the connection
pool. The default is 10.

Startup Backoff
Timeout (sec)

7. Click Save Connection.

The connection you created appears on the adapter's Connections screen.

8. Be sure to enable the connection before you create adapter services that use it. See “Enabling
Adapter Connections” on page 67 for instructions.

Dynamically Changing a Service's Connection at Run Time

You can run an adapter service using a connection other than the default connection that was
associated with the service when it was created. To override the default, you must code your flow
service to pass a value through the pipeline into the adapter service's $connectionName field.

For example, you have a flow service that creates a new account for the Account Salesforce object
in the Salesforce.com production area. However, for testing purposes you want the flow service
to have the capability to create the account in the Salesforce.com Sandbox. At run time, you want
the flow service to determine programmatically whether to create the account in the production
area or the Sandbox. Set up your flow service to have a Target variable so that it can branch its
logic based on the value in Target:

If Target contains the value production, the flow service does not specify a value for the
$connectionNamepipeline variable, which causes the adapter service to use its default connection
to the production area.

If Target contains the value test, the flow services sets the $connectionName variable to the
connection for the Sandbox so that the adapter service creates the account in the Sandbox.

Alternatively, you can use the configured connection for an adapter service, but at run time override
the Salesforce.com user credentials defined in the connection. To override the user credentials,
you must code your flow service to pass values through the pipeline into the adapter service's
username and password fields.

Note:
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When using the Salesforce.com OAuth connection for an adapter service, changing the OAuth
connection user credentials (username and password) at runtime causes the adapter to create a
normal Salesforce.com connection with these credentials.

For more information, see “Changing the Connection Associated with an Adapter Service at Run
Time” on page 18.

Viewing Adapter Connection Parameters

You can view a connection's parameters from Integration Server Administrator and Designer.

Viewing Parameters Using Integration Server Administrator

To view the parameters for an adapter connection using Integration Server Administrator

1. In the Adapters menu in Integration Server Administrator's navigation area, click Adapter
for Salesforce.

When using the adapter with Integration Server 8.2 and later, you can sort and filter the list
of connections that appears on the Connections screen.

To sort information on the Connections screen, click the Up and Down arrows at the top
of the column you want to sort.

To filter the list of connections:

1. On the Connections screen, click Filter Connections.

2. Type the criterion by which you want to filter into the Filter criteria box. Filtering is
based on the node name, not the connection alias. To locate all connections containing
specific alphanumeric characters, use asterisks (*) as wildcards. For example, if you
want to display all connections containing the string "abc", type *abc* in the Filter
criteria box.

3. Click Submit. The Connections screen displays the connections that match the filter
criteria.

4. To re-display all connections, click Show All Connections.

The Connections screen appears, listing all the current connections. You can control the number
of connections that are displayed on this screen. For more information, see “Controlling
Pagination” on page 31.

2. On the Connections screen, click for the connection you want to see.

The View Connection screen displays the parameters for the connection. For descriptions of
the connectionparameters, see the table of parameters in “ConfiguringAdapterConnections” on
page 56.
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3. ClickReturn to Adapter 8.2 for Salesforce Connections to return to the Connections screen.

Viewing Parameters Using Designer

To view the parameters for an adapter connection using Designer

1. From the Designer navigation area, open the package and folder in which the connection is
located.

2. Double-click the connection you want to view.

The parameters for the connection appear in theConnection Information tab. For descriptions
of the connection parameters, see the table of parameters in “Configuring Adapter
Connections” on page 56.

Editing Adapter Connections

Use Integration Server Administrator to redefine parameters for a connection.

To edit an adapter connection

1. Disable the connection you want to edit. See “Disabling Adapter Connections” on page 68 for
instructions.

2. In Integration Server Administrator, select Adapters>Adapter for Salesforce.

3. On the Connections screen, click for the connection you want to edit.

In the Edit Connection screen, update the parameters by typing or selecting the values you
want to specify. For descriptions of the connection parameters, see “Configuring Adapter
Connections” on page 56.

4. Click Save Changes to save the connection and return to the Connections screen.

5. Enable the connection you edited. See “Enabling Adapter Connections” on page 67 for
instructions.

Copying Adapter Connections

You can copy an existing Adapter for Salesforce connection to create a new connection with the
same or similar connection properties without retyping all properties for the new connection.

To copy an adapter connection

1. In Integration Server Administrator, select Adapters>Adapter for Salesforce.
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2. On the Connections screen, click for the connection you want to copy.

The Copy Connection screen displays the current parameters for the connection you want to
copy. Name the new connection and edit any connection parameters as needed by typing or
selecting the values you want to specify. For descriptions of the connection parameters, see
“Configuring Adapter Connections” on page 56.

3. Click Save Connection Copy to save the connection and return to the Connections screen.

Deleting Adapter Connections

You can delete Adapter for Salesforce connections that you no longer want to use.

When you delete a Adapter for Salesforce connection, the adapter services that are defined to use
the connection will no longer work. To assign a different connection to an adapter service and
re-use the service, use the webMethods setAdapterServiceNodeConnection built-in service. For more
information, see “Changing theConnectionAssociatedwith anAdapter Service at Design Time” on
page 17.

To delete an adapter connection

1. Disable the connection you want to delete. See “Disabling Adapter Connections” on page 68
for instructions.

2. In Integration Server Administrator, select Adapters>Adapter for Salesforce.

3. On the Connections screen, click for the connection you want to delete.

Integration Server deletes the adapter connection.

Enabling Adapter Connections

Adapter connectionsmust be enabled before you can create adapter services or adapter notifications
for those connections.

Note:
Whenyou reload a package that contains enabled connections, the connectionswill automatically
be enabled when the package reloads. If the package contains connections that are disabled,
they will remain disabled when the package reloads.

To enable an adapter connection

1. In Integration Server Administrator, select Adapters>Adapter for Salesforce.

2. On the Connections screen, click No in the Enabled column for the connection you want to
enable.
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Integration Server Administrator enables the adapter connection and displays and Yes in
the Enabled column.

Disabling Adapter Connections

Adapter connections must be disabled before you can edit or delete the connections.

To disable an adapter connection

1. In Integration Server Administrator, select Adapters>Adapter for Salesforce.

2. On the Connections screen, click Yes in the Enabled column for the connection you want to
disable.

Integration Server Administrator disables the adapter connection and displays No in the
Enabled column.
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Overview

The following sections describe how to configure adapter services, which you use forwebMethods
to Salesforce.com communications.

Before you configure Adapter for Salesforce services, you must configure the connections you
plan to use with them. For details, see “Configuring Adapter Connections” on page 56.

Before Configuring or Managing Adapter Services

To prepare to configure or manage an adapter service

1. Start your Integration Server and Integration Server Administrator, if they are not already
running.

2. Make sure you have Integration Server administrator privileges so that you can access the
Adapter for Salesforce administrative screens. For information about setting user privileges,
see the webMethods Integration Server Administrator’s Guide for your release.

3. Using Integration Server Administrator, make sure the WmSalesforceAdapter package is
enabled. For instructions, see “Enabling and Disabling Packages” on page 41.

4. Using Integration Server Administrator, configure an adapter connection to use with the
adapter service. For instructions, see “Configuring Adapter Connections” on page 56.

5. Start Designer if it is not already running.

6. Using Designer, create a package to contain adapter services, if you have not already done so.
When you configure adapter services, define them in user-defined packages instead of in the
WmSalesforceAdapter package. For more information about managing packages for the
adapter, see Adapter Package Management.

7. Optionally, you can configure the watt.adapter.salesforce.sobjects.batchSize watt property in
Integration Server Administrator to set the batch size for the retrieval ofmetadata for Salesforce
objects. If you do not specify a value for the property, the adapter uses as a default value the
maximum limit size of a batch of Salesforce objects (100) set by Salesforce.com.

For information about configuring thewatt.adapter.salesforce.sobjects.batchSizewatt property,
see the webMethods Integration Server Administrator’s Guide for your release.

Configuring Adapter Services

You can configure adapter services that perform the following operations:
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For more information, see...Operation

“Configuring Batch Operation
Adapter Services” on page 73

Handle a large number of records of a Salesforce object.
The service performs the following operations against a
batch of Salesforce object records:

inserts new records.

updates records.

inserts or updates records.

deletes records.

performs a query to find records and return field values
from matching records.

“Configuring Create Operation
Adapter Services” on page 75

Insert new records into one or multiple Salesforce objects.

“Configuring Custom Query
Operation Adapter Services” on
page 77

Perform a dynamic SOQLquery against a Salesforce object.

“Configuring Delete Operation
Adapter Services” on page 81

Delete records from an organization's data.

“Configuring Monitor Batch
Operations Adapter Services” on
page 82

Monitor the status and display the results of a batch
operation.

“Configuring Query Operation
Adapter Services” on page 84

Perform a query against a Salesforce object to return field
values from matching records.

“Configuring Retrieve Operation
Adapter Services” on page 88

Retrieve field values of specified records of a Salesforce
object. Use this operation when you know the IDs of the
records from which you want field values.

“Configuring Update Operation
Adapter Services” on page 90

Update records of one or multiple Salesforce objects.

“Configuring Upsert Operation
Adapter Services” on page 92

Perform an upsert operation to either insert new records
into or update records of a Salesforce object.

“Configuring Utility Operation
Adapter Services” on page 96

Execute the Salesforce.com getServerTimestamp utility.

“Configuring Utility Operation
Adapter Services” on page 96

Execute the Salesforce.com getSessionId utility.

“Configuring Utility Operation
Adapter Services” on page 96

Execute the Salesforce.com getUserInfo utility.
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For more information, see...Operation

“Configuring Utility Operation
Adapter Services” on page 96

Execute the Salesforce.com resetPassword utility.

“Configuring Utility Operation
Adapter Services” on page 96

Execute the Salesforce.com sendEmail utility.

“Configuring Utility Operation
Adapter Services” on page 96

Execute the Salesforce.com sendMassEmail utility.

“Configuring Utility Operation
Adapter Services” on page 96

Execute the Salesforce.com setPassword utility.

Assigning External IDs to sObject Record Fields

Each record in an sObject is identified uniquely by an Internal ID that SalesforceAdapter generates
automatically. To create a record in a table which has a reference to a record in another sObject,
you can mark fields in an sObject with External IDs. When you assign an External ID to a record
field, you can identify that record not only by the Internal ID, but also by the External ID field.
You can easily access and refer to the value of a field in an sObject designated as an External ID.
The adapter service will show all the External ID fields. Select the desired External ID, and save
the service.

Important:
The External ID fields are used only for Create, Update, and Upsert adapter services.

Note:Adapter for Salesforce uses either the Internal ID or the External ID when making calls to
the backend. You cannot use both the Internal ID and the External ID.

For example, as shown in the following screenshot, you can identify uniquely a record in an
"Account" sObject by either the automatically generated Internal ID or by designating any custom
field, for example, "NYSE_ID", to act as an External ID. When creating an “Opportunity” record
for this “Account” record, you would use “NYSE_ID” in place of "Account ID".

Note:
You can use External IDs for existing services without modifying the service. To use External
IDs for an existing service, you must lock the service for editing and reload the adapter fields.

72 webMethods Adapter for Salesforce Installation and User’s Guide 8.2

5 Adapter Services



Configuring Batch Operation Adapter Services

Use the Batch Operation template to configure a service that handles a large number of records
of a Salesforce object. The service performs the following operations against a batch of Salesforce
object records:

Inserts new records.

Updates records.

Inserts and updates records (upsert operation).

Deletes records.

Performs a query to find records and return field values from matching records.

The following table shows the input parameters of the adapter service that you configure.

Note:
Youmust specify a value either for the content or for the filePath input parameter. For information
about what the content and file format should be, see the Salesforce documentation.

DescriptionInput Variable

Takes an object and maps it to actual data. The data type of the content
parameter can be byte array, string, InputStream, or Reader.

content

String Loads the Salesforce object records from a csv file.filePath

String Optional. Indicates the specific encoding for the data that the service
passes. The default value is UTF-8.

encoding

The following table shows the output parameters of the adapter service that you configure.

DescriptionOutput Variable

String The ID of the job created to perform the operation.jobId

String List The ID of the batches of records for which the service returns the
results from the executed operation.

batchId

Note:
The values of the jobId and batchId output variables are used as input variables of the Monitor
Batch Operations service. For information about the Monitor Batch Operations service, see
“Configuring Monitor Batch Operations Adapter Services” on page 82.

To configure an adapter service using the Batch Operation template

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.
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2. Start Designer.

3. Right-click the package in which the service should be contained and select New > Adapter
Service.

4. Select the parent namespace, type a name for the adapter service, and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

7. From the list of available templates, select the Batch Operation template and click Finish.

The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

8. Select the Batch Operation tab.

9. From theSalesforce Object field, select the Salesforce object onwhich the servicewill perform
the required bulk operation.

10. From the Salesforce Bulk Operations field, select the type of bulk operation that you want
the service to perform:

insert

update

upsert

delete

query

11. In the Max number of rows per batch field, specify the number of rows that should be
included in each batch. Any positive number is a valid value.

Note:
This field applies only for the insert, update, upsert, and delete operations. You cannot
specify a value in this field when you select the query operation in the previous step.

12. If you selected the upsert bulk operation, from the ID Field Name list, select the field that you
want to use to determine whether a record already exists in the Salesforce object.

At run time, pass a value for this field as input into the adapter service. If the value matches
an existing record, the adapter service updates the record. If the value does not match an
existing record, the adapter service inserts a new record.
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Note:
If you do not specify any value at run time, the adapter service neither inserts nor updates
the record.

13. Select File > Save to save the adapter service.

Note:
If you are using JVM version below 1.8, set the property
wrapper.java.additional.8=-Dhttps.protocols=TLSv1.2 in the location,
webMethods_directory/profiles/IS_default/configuration/wrapper.conf file. Here, 8 is a sample
number. Therefore, set it to the next available number. This property should be added under
Java Additional Parameters.

Configuring Create Operation Adapter Services

Use the Create Operation template to configure an adapter service that inserts new records into
one ormultiple Salesforce objects. For example, youmight configure an adapter service that inserts
new contacts into the Contact Salesforce object, or a service that inserts new records into both the
Contact and Account Salesforce objects. The Create operation wraps the create call of the
Salesforce.comWeb service API.

The Salesforce.com create call returns a SaveResult object. The adapter service returns the information
from the SaveResult object as output.

DescriptionOutput Variable

String The ID of a newly inserted record.id

BooleanWhether the create call successfully inserted a
record. If success is:

success

true New record inserted successfully.

false New record insertion failed.

String ListWhen success is false, errors provides the
error codes and descriptions of the errors that the create
call encountered.

errors

The input signature of the adapter service contains the name of the Salesforce object or objects that
you selected as input parameters. For example, when you select the Account object, the input
signature contains Account as input parameter. Each object is a Document List that holds the field
values for the records to insert. At run time, pass the adapter service one Document within the
sobjects Document List for each record you want to insert.

The output signature of the adapter service contains a results Document List. Each Document in
the input sobjects Document List maps to an output Document in the results Document List.
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To configure an adapter service that uses the Create Operation template

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. Start Designer.

3. Right-click the package in which the service should be contained and select New > Adapter
Service.

4. Select the parent namespace, type a name for the adapter service, and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

Important:
Ensure that the Salesforce.comuser account identified by the connection has all the required
permissions to insert a record in the Salesforce object that you will select later in the
procedure. See “Configuring Adapter Services” on page 70 for more information.

7. From the list of available templates, select the Create Operation template and click Finish.

The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

8. In the Select column on the Schema tab, select the check boxes for one or more Salesforce
objects into which you want to insert new records.

9. To use an External ID for a Salesforce object, select the check box for the Salesforce object in
the Show External ID column.

10. To identify the fields to include in the new records:
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a. Select the Create Operation tab.

b. Click the icon to populate the table with the creatable fields of the selected Salesforce
objects.

c. For each field that you want to include in the new record, select the check box in the Use
Field column.

For example, if you are defining an adapter service that inserts records into the Account
and Contact Salesforce objects, you might define the adapter service to provide values for
theAccount.Name,Account.Type, andAccount.ParentId fields, and the Contact.LastName
and Contact.FirstName fields.

The fields and the objects become part of the input signature for the adapter service.When
invoking the adapter service, pass the values for these fields as input. The adapter service
uses those input values when creating the new records.

Important:
Be sure to select all required fields for a record and all fields required to maintain the
referential integrity of the Salesforce object.

Note:
The Create Operation template does not list fields that are automatically created when
a new record is added, for example, CreatedDate, CreatedById, LastModifiedDate,
LastModifiedById, and SystemModstamp.Although you cannot select these fields, they
will be included in new records. Also, the Create Operation template shows only those
fields that are marked "creatable" for the create operation.

At run time, the adapter service determines whether the values specified for the fields are
valid, for example ensuring that a date value is specified for a field that has a java.util.Date
data type. If an invalid value is detected, the adapter issues an error message and does not
attempt to insert the new records.

d. To create a record in a table that has a reference to a record in another sObject, select the
fields in an sObject designated with External IDs. The Relationship Name column shows
the sObject record that the selected External ID field relates to. For information about how
to assign an External ID to a record field, see “Assigning External IDs to sObject Record
Fields” on page 72.

11. Select File > Save to save the adapter service.

Configuring Custom Query Operation Adapter Services

Use the Custom Query Operation template to create a query service that allows you to configure
a dynamic Salesforce Object Query Language (SOQL) statement, part of which you set at run time
using input fields. At run time, the service will create the SOQL statement by combining the
contents of the input fields and then executing the statement. This is useful when you need the
flexibility to set all or part of an SOQL statement at run time instead of at design time.
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The Custom Query Operation service performs a query against a Salesforce object to find records
and return selected field values from those records.

Also, when you configure a custom query, you must provide all the fields of the parent object and
then the fields of the child object.

For example, in the following query statement:
SELECT Account.type,Account.Name, Contact.FirstName, Contact.LastName FROM Contact

Provide all the fields of the parent object which is the Contact and then provide all the fields of
the child object which are Account.type,Account.Name, Contact.FirstName, Contact.LastName.

Note:

Ensure that all the fields in the parent object is entered before you enter the fields of the child
object.

Input and output parameters for the service are optional. An input parameter is required only
when the SOQL statement contains the ? placeholder variable. Each ? in the statement corresponds
to an input parameter. For example, in the following query statement:
SELECT ?, Account.Name, (SELECT Contact.FirstName, Contact.LastName
FROM Account.Contacts) FROM Account ?

you should configure only two input parameters, because the statement contains two ? placeholder
variables.

You configure an output parameter only when you want to overwrite the default field name in
the output result. For example, in the following query statement:
SELECT Contact.FirstName, Contact.Account.Name FROM Contact

if you do not configure any output parameters, the service will populate the output result with
FirstName and Name as the parameters in the output IData. If you want to overwrite the default
parameterswith FNAME andAccountName, set the output parameters to FNAME andAccountName.

You must specify the input and output parameters of the adapter service at design time. When
you configure the service, the input fields will contain the input for the SOQL statement. The
output fieldswill contain the results from the result set. Make sure that the input and output fields
correctly match those of the SOQL statement. If there is any mismatch, the service will generate
an exception at run time.

Configuring a Custom SOQL Statement
Custom SOQL uses the ? placeholder variable to map part of the SOQL statement to the input
field. At design time, you need to add an input parameter for each ? placeholder variable in the
SOQL statement.

For example, in the following SOQL statement:
SELECT Account.Id, Account.Name, (SELECT Contact.FirstName, Contact.LastName
FROM Account.Contacts) FROM Account where Name IN (‘XXX’)
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if you want to pass values for Account.Id and the where condition at run time, write the following
SOQL statement:
SELECT ?, Account.Name, (SELECT Contact.FirstName, Contact.LastName
FROM Account.Contacts) FROM Account ?

In this case, you need to add two input parameters - AccId and whereCondition. When the service
executes, specify the following values for the parameters:

AccId = Account.Id

whereCondition = where Name IN (‘XXX’), where XXX is the actual account name

Configuring a Custom Query Operation Adapter Service

To configure an adapter service using the Custom Query Operation template

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. Start Designer.

3. Right-click the package in which the service should be contained and select New > Adapter
Service.

4. Select the parent namespace, type a name for the adapter service and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

7. From the list of available templates, select the Custom Query Operation template and click
Finish.

The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

8. Select the Custom Query Operation tab to specify an SOQL statement and the associated
input and output parameters.

a. Select the Include Deleted Records check box to include results from deleted records.

b. Use the icon and set the SOQL parameters as described in the table below.
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Description/ActionField

An SOQL statement. If you need more space to type your
statement, use the launch icon to the right to open a text editor

Salesforce SOQL Query

window. You can type the statement directly in this field, for
example: SELECT Id, Name FROM Account WHERE Name =
‘Sandy’.

For variable names, use the ? variable placeholder for each
variable. For example: SELECT Id, Name FROM Account WHERE
Name = ?

Note:
If you use the ? placeholder variable in your SOQL
statement,make sure that you enter the corresponding Input
Field and Input Field Type information in the same order
as they appear in your SOQL statement. In the example
given earlier, Name corresponds to the first entry in the Input
Field.

Note:
Do not end your SOQL statement with a semi-colon (;) or
an exception will be generated.

Note:
You can paste text into this field from the system clipboard.
However, you must not cut or copy text from this field to
the clipboard for pasting into another application.

The name of the input field.Input Field

java.lang.StringInput Field Type

Output parameters are optional. You configure an output
parameter only when you want to overwrite the default field
name in the output result.

Output Field

Note:

While mapping the output fields, ensure that the data
entered in the output fieldmatches the field name provided
in the SOQL statement.

The native field type of the selected field. Salesforce supports
various types of native fields: string, picklist, multipicklist,

Native Field Type

reference, base64, textarea, phone, id, url, email,
encryptedstring, combobox, anyType, time, boolean, int,
double, currency, percent, date, datetime. You need to select
the appropriate field type.
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Description/ActionField

The Java data type for the selected native field type. The java
field type is automatically selected, after you select the native
field type.

Output Field Type

9. Select File > Save to save the adapter service.

Configuring Delete Operation Adapter Services

Use theDelete Operation template to configure an adapter service that deletes records from your
organization's data. For example, you might configure an adapter service that deletes contacts
from the Contact Salesforce object. The Delete operation wraps the delete call of the Salesforce.com
Web service API.

The input to the adapter service includes an ID String List. At run time, pass the adapter service
the ID of each record to delete. Each ID is a String value within the ID String List.

As a response, the Salesforce.com delete call returns a DeleteResult object. The adapter service
returns the information from the DeleteResult object as output.

DescriptionOutput Variable

String The ID of a deleted record.id

BooleanWhether the delete call successfully deleted a record.success

String List If success is false, errors provides the error codes and
descriptions of the errors that the delete call encountered.

errors

The IDs of the records to delete in the ID String List input parameter map to the output in the
results Document List.

To configure an adapter service that uses the Delete Operation template

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. Start Designer.
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3. Right-click the package in which the service should be contained and select New > Adapter
Service.

4. Select the parent namespace, type a name for the adapter service, and click Next.

5. Select Salesforce.com Adapter as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

Important:
Ensure the Salesforce.com user account identified by the connection has all the required
permissions to delete records from the Salesforce object.

7. From the list of available templates, select the Delete Operation template and click Finish.

The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

8. Select File > Save to save the adapter service.

Configuring Monitor Batch Operations Adapter Services

Use theMonitor BatchOperations template to configure an adapter service thatmonitors the status
and displays the results of the batch operations executed by the adapter’s BatchOperation service.

The input signature of the adapter service contains the values of the jobId and batchId output
parameters of the BatchOperation service. Formore information about the BatchOperation service,
see “Configuring Batch Operation Adapter Services” on page 73.

The following table shows the input parameters of the Monitor Batch adapter service that you
configure.

DescriptionInput Variable

String The ID of the job created to perform the
batch operation.

jobId

String List The ID of the batches of records for
which the service returns the results from the
executed operation.

batchId

String Applies for query operation only. Allows
you to view the results of a batch query operation
as a file.

filePath

The following table shows the output parameters of the adapter service that you configure.
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DescriptionOutput Variable

Document ListBatch

The list contains the following parameters:

Batch IDStringThe ID of the batch specified in the input
parameters.

Batch Status String The status of the bulk operation
performed against the batchwith the specified Batch ID.

Batch Error Message String Shows any errors that occur
when the bulk operation is performed against the batch
with the specified Batch ID.

ResultDocument List The result of the bulk operation
performed against the batchwith the specified Batch ID.

Id String The ID of the performed bulk operation in
the backend.

Status String The status of the bulk operation for a
record.

Error String Shows any errors that occur when the
bulk operation is performed for a record.

The following screenshot shows the Batch output parameter of the Monitor Batch Operations
adapter service.

To configure an adapter service using the Monitor Batch Operations template

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. Start Designer.

webMethods Adapter for Salesforce Installation and User’s Guide 8.2 83

5 Adapter Services



3. Right-click the package in which the service should be contained and select New > Adapter
Service.

4. Select the parent namespace, type a name for the adapter service, and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

7. From the list of available templates, select the Monitor Batch Operations template and click
Finish.

The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

8. From the Monitor Batch Operations tab, in the Select Monitor Operation field, select one
of the following:

To viewField

The status of a batch created during an insert, update,
upsert, delete, or query operation.

Batch Information

The status and the results of a batch created during
an insert, update, upsert, or delete operation.

Batch Information & Results

The status and the results of a batch created during a
query operation.

Query Operation - Batch Information
& Results

The results of a query operation as a file.Query Operation - Batch Results as
File

9. Select File > Save to save the adapter service.

Configuring Query Operation Adapter Services

Use the Query Operation template to configure an adapter service that executes a Salesforce
Object Query Language (SOQL) query against a Salesforce object, to find records and return
selected field values from those records. For example, youmight configure an adapter service that
queries the Contact Salesforce object to find contacts who have a specific Title and return values
for the FirstName, LastName, and Phone fields.

The Query operation wraps the query, queryAll, and queryMore calls of the Salesforce.comWeb service
API. The query call executes the initial query to retrieve the initial matching records. If the response
from the query call indicates that there are additional records to retrieve, the adapter service executes
the queryMore call as many times as necessary to retrieve all records. The queryAll call identifies the
records that have been deleted because of a merge or delete operation.
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At run time when you invoke the service, pass the input parameters to the adapter service if you
have specified variables in theWHERE clause. The adapter service generates the query and executes
the query.

As a response, the Salesforce.com query and queryMore calls return a QueryResult object, which
includes the selected field values of the matching records and a flag indicating whether there are
additional matching records to retrieve. The queryAll call returns all existing and deleted records.

The following table describes the output from a Query Operation adapter service:

DescriptionVariable

Document ListEachDocument in theDocument List contains the selected
fields for a record that matched the specified query.

results

To configure an adapter service that uses the Query Operation template

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. Start Designer.

3. Right-click the package in which the service should be contained and select New > Adapter
Service.

4. Select the parent namespace, type a name for the adapter service, and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

Important:
Ensure the Salesforce.com user account identified by the connection has all the required
permissions to query records from the Salesforce object that you will select later in the
procedure.

7. From the list of available templates, select the Query Operation template and click Finish.
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The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

8. Identify the Salesforce object that you want to query.

a. Select the Schema tab.

b. From the Salesforce object list, select the Salesforce object you want to query.

c. Select the Include Deleted Records checkbox to include all existing and deleted records.

d. Click the icon to reload the adapter values.

9. Identify the fields of the matching records that youwant returned. If you do not specify fields,
the adapter throws an error stating MALFORMED_QUERY.

a. Select the Query Operation tab.

b. Click the icon to populate the table with the fields of the selected Salesforce object.

c. For each field you want returned, select the check box in the Use Field column.

For example, if you are querying the Account Salesforce object, you may select to have the
adapter service return the "Account ID" and "AccountName" fields of thematching records.

10. Optionally, define how you want the adapter to sort the retrieved records.

a. For each field you want to sort by, in the Sort Order column select a sort order option.
Only specify a sort option for fields you select using the Use Field check box. The adapter
ignores sort options that you specify for non-selected fields.

To sort the results in...Select this option...

Ascending order by the field value, with the null
values at the beginning of the results.

ASC NULLS FIRST

Ascending order by the field value, with the null
values at the end of the results.

ASC NULLS LAST

Descending order by the field value, with the null
values at the beginning of the results.

DESC NULLS FIRST

Descending order by the field value, with the null
values at the end of the results.

DESC NULLS LAST
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b. If you are sorting by multiple fields, move the rows into the order in which you want the
adapter to perform the sorts. The adapter performs each sort in the order the rows are
listed on the Query Operation tab.

To move a row, select it and then click the icon to move the row up, or click the icon
to move the row down.

For more information about sorting, including factors that affect sorting and data type
limitations, see the Force.com Web Services API Developer's Guide.

11. Optionally, you can use the WHERE field to filter the search results for an object based on
specific field values. You specify the filter using Salesforce Object Query Language (SOQL).
If you leave the WHEREfield blank, the adapter returns all records in the Salesforce object
specified on the Schema tab.

You can either specify theWHERE condition or you can use variables.When you use variables
in aWHERE clause, use ${INPUT_FIELD_NAME} tomap a part of the clause to the input field.
At design time, the service template generates an input field with INPUT_FIELD_NAME,
which allows you to specify placeholders within the WHERE clause (conditional Expression)
free text area to define input parameters. At run time, the service parses the WHERE clause
and replaces the ${INPUT_FIELD_NAME} with the actual contents of the input field.

For example, consider the following WHERE clauses:

Name = '${ name }' and Sales > 200000

In this example, the service template will generate an input field for name. At run time,
${name} is replaced with the value of name variable.

If you specify Jack as the value for the name input field, then the resultant WHERE clause
is:
Name = 'Jack' and Sales > 200000

Name = '${name}' and Sales > ${amount}

In this example, the service template will generate input fields for name and amount .

${ where }

In this example, the service template will generate an input field for where . In the where
input field, you can specify any condition.

Type = ‘Customer' or ${condition}

In this example, the service template will generate an input field for condition . In the
condition input field, you can specify the dynamic condition.

For more information about SOQL and the WHERE conditionExpression, see the Force.com
Web Services API Developer's Guide.

12. In the Maximum Rows field, type a positive, whole number to specify the maximum number
of records that you want returned. If you want all records to be returned, type 0.

webMethods Adapter for Salesforce Installation and User’s Guide 8.2 87

5 Adapter Services



13. Select File > Save to save the adapter service.

Configuring Retrieve Operation Adapter Services

Use the Retrieve Operation template to configure an adapter service that retrieves selected fields
from records of a Salesforce object. TheRetrieve operationwraps the retrieve call of the Salesforce.com
Web service API.

The input to the adapter service includes an ID String List. At run time, pass the adapter service
the ID of each record to retrieve. Each ID is a String value within the ID String List.

As a response, the Salesforce.com retrieve call returns the objects that contain the field values of the
retrieved records.

The following table describes the output from a Retrieve Operation adapter service:

DescriptionVariable

Document List Each Document in the Document
List contains the selected fields of the retrieved
records.

results

There is a one-to-one mapping between the IDs
of the records specified in the ID input parameter
to the output in the results Document List.

String ListContains the list of invalid IDs.invalidIds

If the user does not have sufficient privilege or if
one or more IDs specified in the input parameter
are invalid, the response from the Salesforce.com
retrieve() call is null. Adapter for Salesforce cannot
retrieve the records for invalid IDs. These invalid
IDs are made a part of the invalidIds output
parameter.

Note:
When there are invalid IDs in the invalidIds
output parameter, the number of records in the
results output parameter will not match the
number of IDs specified in the input signature.

The IDs of the records to retrieve in the IDString List input parameter map to the output in the
results Document List.
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Note:
Salesforce.com imposes restrictions on the number of IDs that can be passed for a single call.
Ensure that the number of IDs passed to a single Retrieve operation does not exceed the
maximum limit. For more information, see the Force.com Web Services API Developer's Guide.

To configure an adapter service that uses the Retrieve Operation template

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. Start Designer.

3. Right-click the package in which the service should be contained and select New > Adapter
Service.

4. Select the parent namespace, type a name for the adapter service, and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

Important:
Ensure the Salesforce.com user account identified by the connection has all the required
permissions to retrieve records from the Salesforce object that you will select later in the
procedure.

7. From the list of available templates, select the Retrieve Operation template and click Finish.

The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

8. Identify the Salesforce object from which the adapter service is to retrieve records.

a. Select the Schema tab.

b. From theSalesforce object list, select the Salesforce object fromwhich youwant to retrieve
records.
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9. Identify the fields of the retrieved records that you want returned. If you do not specify fields,
the adapter reports an INVALID_FIELD error, which Salesforce.com returns.

a. Select the Retrieve Operation tab.

b. Click the icon to populate the table with the fields of the selected Salesforce object.

c. For each field want returned, select the check box in the Use Field column.

10. Select File > Save to save the adapter service.

Configuring Update Operation Adapter Services

Use the Update Operation template to configure an adapter service that updates records of one
or multiple Salesforce objects. The update operation wraps the update call of the Salesforce.com
Web service API.

As a response, the Salesforce.com update call returns a SaveResult object. The adapter service returns
the information from the SaveResult object as output.

DescriptionOutput Variable

String The ID of an updated record.id

BooleanWhether the update call successfully updated
a record. If success is:

success

true Records were updated successfully.

false Updating records failed.

String ListWhen success is false, errors provides the
error codes and descriptions of the errors that the update
call encountered.

errors

The input signature of the adapter service contains the name of the Salesforce object or objects that
you selected as input parameters. For example, when you select the Account object, the input
signature contains Account as input parameter. Each object is a Document List that holds the field
values and IDs for the records to update. At run time, pass the adapter service one Document
within the sobjects Document List for each record you want to update.

The output signature of the adapter service contains a results Document List. Each Document in
the input sobjects Document List maps to an output Document in the results Document List.
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To configure an adapter service that uses the Update Operation template

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. Start Designer.

3. Right-click the package in which the service should be contained and select New > Adapter
Service.

4. Select the parent namespace, type a name for the adapter service, and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

Important:
Ensure the Salesforce.com user account identified by the connection has all the required
permissions to update records in the Salesforce object that you will select later in the
procedure.

7. From the list of available templates, select the Update Operation template and click Finish.

The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

8. In the Select column on the Schema tab, select the check boxes for one or more Salesforce
objects into which you want to update records.

9. To use an External ID for a Salesforce object, select the check box for the Salesforce object in
the Show External ID column.
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10. On the Update Operation tab, click the icon to populate the table with the fields of the
Salesforce objects you selected.

11. In the Use Field column, select the check box for every name Id field in the Input Parameter
column, where name is the name of the Salesforce object you selected.

For example, if you selected the Account and Contact Salesforce objects, you have to select the
check boxes for the Account.Id and Contact.Id fields respectively.

The name Id field is included in the input parameters, providing a variable for passing the IDs
of the records that the adapter service is to update.

12. For each field that you want to update in the record, select the check box in the Use Field
column.

For example, if you are defining an adapter service that updates records in the Account and
Contact Salesforce objects, you might set up the adapter service to update the Account.Name
and Account.Type fields, and the Contact.LastName and Contact.FirstName fields.

The fields you specify becomepart of the input signature for the adapter service.When invoking
the adapter service, pass the values for the selected fields as input. To reset a non-required
field to null, pass a null value for the field.

Important:
Whenusing an update operation adapter service, be sure to specify field values thatmaintain
the referential integrity of the Salesforce objects.

Note:
The Update Operation template lists only fields that you can update for a Salesforce object.
If Salesforce.comdoes not allow you to update a field, for example theMasterRecordId field
for a Contact Salesforce object, the adapter service template does not list the field for selection.

At run time, the adapter service determines whether the values specified for the fields are
valid, for example ensuring that a date value is specified for a field that has a java.util.Date
data type. If an invalid value is detected, the adapter issues an error message and does not
attempt to update the record.

13. To update a record in a table that has a reference to a record in another sObject, select the fields
in an sObject designatedwith External IDs. TheRelationship Name column shows the sObject
record that the selected External ID field relates to. For information about how to assign an
External ID to a record field, see “Assigning External IDs to sObject Record Fields” on page 72.

14. Select File > Save to save the adapter service.

Configuring Upsert Operation Adapter Services

Use theUpsert Operation template to configure an adapter service that inserts records or updates
records of a Salesforce object.When attempting to addnew records, you canuse the upsert operation
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instead of the create operation to avoid the potential of inserting duplicate records. The upsert
operation wraps the upsert call of the Salesforce.comWeb service API.

Important:
In the Salesforce.com Partner WSDL version 25.0, all records must have the same object type in
an upsert() call.When you selectmultiple Salesforce objects, Salesforce.com throws an exception.

For the upsert operation, you specify the value of a field that the operation uses to determine
whether a record already exists. The field must be:

For standard objects, a field with the idLookup property. This is usually the object's ID, Name
field, or both.

For custom objects, a field with the external ID attribute.

If the record does not already exist, the upsert operation inserts it. If the record does exist, the
upsert operation updates it. You cannot create or update the values of the fields, which are auto
generated by Salesforce.com.

As a response, the Salesforce.com upsert call returns an UpsertResult object. The adapter service
returns the information from the UpsertResult object as output.

DescriptionOutput Variable

Boolean Whether the upsert operation inserted or
updated the specified record. The value of created is

created

true if the upsert operation inserted the record or
false if the upsert operation updated the record.

StringThe ID of the created or updated recordwhen
success is true. If success is false, id is null.

id

Boolean Whether the upsert call successfully
inserted/updated the record.

success

String List If success is false, errorsprovides the error
codes and descriptions of the errors that the upsert
call encountered.

errors

The input signature of the adapter service uses an sobjects Document List, which holds the field
values the upsert operation uses. At run time, pass the adapter service one Document within the
sobjects Document List for each record on which you want to act.

The output signature of the adapter service contains a results Document List. Each Document in
the input sobjects Document List maps to an output Document in the results Document List.
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To configure an adapter service that uses the Upsert Operation template

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. Start Designer.

3. Right-click the package in which the service should be contained and select New > Adapter
Service.

4. Select the parent namespace, type a name for the adapter service, and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

Important:
Ensure the Salesforce.com user account identified by the connection has all the required
permissions to insert/update records in the Salesforce object that you will select later in the
procedure.

7. From the list of available templates, select the Upsert Operation template and click Finish.

The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

8. To identify the Salesforce object on which you want the adapter service to act and the field to
use to determine whether a record already exists:

a. Select the Schema tab.

b. In the Salesforce Object column, select the Salesforce object for which you want to
insert/update records from the drop-down list.
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Designer updates the ID Field Name field with values based on the Salesforce object that
you select.

Note:
TheUpsert Operation service supports creating/updating records for a single Salesforce
object at a time. Adding rows in the Salesforce Object column does not affect the ID
Field Name list.

c. From the ID Field Name list, select the field that you want to use to determine whether a
record already exists in the Salesforce object.

At run time, pass a value for this field as input into the adapter service. If the valuematches
an existing record, the adapter service updates the record. If the value does not match an
existing record, the adapter service inserts a new record.

9. Include the ID Field Name that you selected earlier in the procedure to the input parameters
to provide a variable for passing the value that the upsert operation uses to determinewhether
a record exists.

a. Select the Upsert Operation tab.

b. Click the icon to add one field row to the table.

c. If the newly added field is not the field you specified for ID Field Name, select that field
from the list in the Input Parameter column.

d. Select the check box in the Use Field column for the field.

Note:
If you do not include the ID Field Name field on the Upsert Operation tab, the upsert
operation will insert new records, generating IDs for each record. If you do include the
ID Field Name field and a value supplied does not match an existing record, the upsert
operation inserts the new record using the value you supply for the field.

10. To identify the fields of the records for which you want to supply information:

a. Select the Upsert Operation tab.
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b. Click the icon to populate the table with the fields of the selected Salesforce object.

c. For each field that you want to supply, select the check box in the Use Field column.

Important:
When using an upsert operation adapter service, be sure to specify field values that
maintain the referential integrity of the Salesforce object.

Note:
The Upsert Operation template lists only fields that can be created and updated.

If the adapter service inserts a record, these are the fields the adapter service supplies for
the new record. If the adapter service updates a record, these are the fields the adapter
service updates. The fields you specify become part of the input signature for the adapter
service.

At run time, the adapter service determines whether the values specified for the fields are
valid, for example, ensuring that a date value is specified for a field that has a java.util.Date
data type. If an invalid value is detected, the adapter issues an error message and does not
attempt to insert/update the record.

d. To upsert a record in a table that has a reference to a record in another sObject, select the
fields in an sObject designated with External IDs. The Relationship Name column shows
the sObject record that the selected External ID field relates to. For information about how
to assign an External ID to a record field, see “Assigning External IDs to sObject Record
Fields” on page 72.

11. Select File > Save to save the adapter service.

Configuring Utility Operation Adapter Services

Use theUtility Operation template to configure an adapter service that invokes one of the following
Salesforce.com utilities:

getServerTimestamp to retrieve the current Salesforce.com system timestamp.

getSessionId to obtain a session ID or an access token that you use to implement custom
Salesforce.comoperations that the adapter does not support. If you use a normal Salesforce.com
connection, getSessionId will return a session ID. If you use an OAuth Salesforce.com
connection, getSessionId will return an access token.

getUserInfo to obtain personal information about the currently logged-in user, that is, the user
account used for the adapter connection. Your adapter service might obtain this information
to use for display purposes.

resetPassword to change a user's password to a temporary, system-generated value.

sendEmail to send a single e-mail message.

sendMassEmail to send multiple e-mail messages.
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setPassword to change the password of a user's password to a specified value.

You select the utility that youwant the adapter service to execute. The input and output signatures
of the adapter service are based on the inputs and outputs of the selected utility. For more
information about utilities and parameters that a utility expects as input or returns as output, see
the Force.com Web Services API Developer's Guide.

To configure an adapter service that uses the Utility Operation template

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. Start Designer.

3. Right-click the package in which the service should be contained and select New > Adapter
Service.

4. Select the parent namespace, type a name for the adapter service, and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

Important:
Ensure the Salesforce.com user account identified by the connection has all the required
permissions to execute the utility that you will select later in the procedure.

7. From the list of available templates, select the Utility Operation template and click Finish.

The adapter service editor for the adapter service appears. You can select theAdapter Settings
tab at any time to confirm adapter service properties such as the Adapter Name, Adapter
Connection Name, and Adapter Service Template, as necessary.

8. Identify the utility that you want the adapter service to invoke.

a. Select the Utility Operation tab.

b. From the Utility Call list, select the utility you want to use.

9. View the Input Fields tab to see the inputs for the utility and the Output Fields tab to see the
outputs that the utility returns. For a description of the input and output fields, see the Force.com
Web Services API Developer's Guide.

10. Select File > Save to save the adapter service.
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Testing Adapter Services

You can test adapter services using Designer. For more information about testing and debugging
services, see the webMethods Service Development Help for your release.

To test an adapter service

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. In Designer, expand the package and folder that contain the service you want to test.

3. Double-click the service you want to test.

Designer displays the configured service in the service template's Adapter Service Editor.

4. Select Run > Run As > Run Service.

5. Optionally, provide the user credentials to connect to Salesforce.com. This user name and
password overrides credentials specified in the adapter connection being used for the adapter
service.

Description/ActionParameter

The user name used to connect to the
Salesforce.com.

username

The password used to connect to the
Salesforce.com.

password

Salesforce.com requires a security token for access
via Force.comWeb service API. You can obtain
the security token from the Salesforce.com user
interface.

For example, if the password is "mypassword" and
the security token is "XXXXXXXXXX", specify the
following for Password and Retype Password:

mypasswordXXXXXXXXXX

Note:
The security token is valid until you reset it,
change your password, or have your password
reset. The security token is not required, if the
endpoint URL is a Salesforce.com sandbox.

6. Specify values for the input parameters of the adapter service.
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7. Optionally, specify an alternative connection to use by providing the connection name in the
$connectionName input parameter.

Note:
Credentials you provide in the username and password fields override any connection.
Specifying the $connectionName input parameter changes the connection for this execution
of the service. To reconfigure the service to use a different connection, use the
setAdapterServiceNodeConnection, which is located in theWmARTpackage's pub.art.service folder.
Formore information about this service, see thewebMethods Integration Server Built-In Services
Reference for your release.

8. Click OK.

9. Click the Service Result tab to view the output from this service.

Viewing Adapter Services

You use Designer to view adapter services.

To view an adapter service

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. In Designer, expand the package and folder that contain the service you want to view.

3. Double-click the service you want to view.

Designer displays the configured service in the service template's Adapter Service Editor.

Editing Adapter Services

You use Designer to edit adapter services.

To edit an adapter service

1. In Designer, browse to and open the adapter service that you want to edit.

2. Double-click the service that you want to edit.

Designer displays the adapter service in the service template's Adapter Service Editor.

3. Do one of the following:

If you have the VCS Integration feature enabled, right-click the service and select Check
Out.
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If you do not have the VCS Integration feature enabled, right-click the service and select
Lock for Edit.

If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check out the service. The options available in the Team
menu depend on the VCS client that you use.

4. Modify the values for the adapter service's parameters as needed. For detailed descriptions of
the service's parameters, see the section on configuring a service for the specific type of service
you want to edit.

5. After you complete your modifications, save the service and do one of the following:

If you have the VCS Integration feature enabled, right-click the service and select Check
In. Enter a check-in comment and click OK.

If you do not have the VCS Integration feature enabled, right-click the service and select
Unlock.

If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check in the service. The options available in the Team
menu depend on the VCS client that you use.

6. Save the service.

Deleting Services

You use Designer to delete adapter services.

To delete a service

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. In Designer, expand the package and folder that contain the service you want to delete.

3. Right-click the adapter service and click Delete.

Validating Adapter Service Values

Designer enables Adapter for Salesforce to validate user-defined data for adapter services at design
time. You can validate the values for a single adapter service or you can configure Designer to
always validate the values for adapter services. Both options could potentially slow your
design-time operations.

When you enable data validation for a single adapter service, Designer compares the service values
against the resource data that has already been fetched from the selected adapter.

If you select the option to always validate values for adapter services, it will do so for all
webMethods WmART-based adapters installed on Integration Server.
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For more information about the Adapter Service/Notification Editor and other Designer menu
options and toolbar icons, see the webMethods Service Development Help for your release.

Enabling Automatic Validation for a Single Adapter Service

To enable automatic data validation for a single adapter service

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. In Designer, expand the package and folder that contain the service for which you want to
enable automatic validation.

3. Double-click the service for which you want to validate the data.

Designer displays the configured adapter service in the service template's Adapter Service
Editor.

4. Click the icon.

Enabling Automatic Validation for All Adapter Services

To always validate the values for all adapter services

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. Start Designer.

3. Select the Window > Preferences > Software AG > Service Development > Adapter
Service/Notification Editor item.

4. Enable the Automatic data validation option.

5. Click OK.

Changing the Credentials Associated with an Adapter Service
at Run Time

Adapter for Salesforce allows users to specify an alternate connection or user credentials at run-time
to invoke the adapter services.

Configure the adapter service to use the default connection (withwhich the servicewas created)
or specify an alternate connection alias, as part of the $connectionNameinput field.

Execute the adapter service by overriding the default credentials, as part of the input signature
for the adapter service. The input signature for the adapter services contains a separate
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document structure: ‘overrideCredentials', with fields $username and $password, for specifying
the username and password to be used for the adapter service execution.

Note:
These dynamic credentials are valid only for the currently selected adapter service during
runtime. The adapter service makes a separate login request and gets a new sessionId, with
which the service call is executed. The adapter service does not use the connection from the
connection pool when dynamic credentials are specified. Ensure that the credentials have
sufficient privilege to perform the operation.

If there are no values specified for the $username and $password fields, the adapter service uses
the default connection.

Note:
When you change the credentials associated with an adapter service at runtime by overriding
thedefault credentials, the adapter communicationwith Salesforce.comdoes not use compression.

Reloading Adapter Values

You can enable Adapter for Salesforce to reload and validate user-defined data for adapter services
at design time in Designer. You can reload values for a single adapter service or you can configure
Designer so it automatically reloads the values for adapter services. Both options could potentially
slow your design-time operations.

When you reload adapter values for a single adapter service, Designer compares the service values
against the resource data that has already been fetched from the selected adapter.

If you select the option to always reload values for adapter services, it will do so for all webMethods
WmART-based adapters installed on Integration Server.

For more information about the Adapter Service/Notification Editor, other menu options, and
toolbar icons, see the webMethods Service Development Help for your release.

Reloading Values for a Single Adapter Service

To reload the adapter values for a single adapter service

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. In Designer, expand the package and folder that contain the service for which you want to
enable automatic validation.
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3. Double-click the service for which you want to validate the data.

Designer displays the configured adapter service in the service template's Adapter Service
Editor.

4. Click the icon.

Reloading Values for All Adapter Services

To reload the adapter values for all adapter services

1. Review the steps in “Before Configuring or Managing Adapter Services” on page 70.

2. Start Designer.

3. Select the Window > Preferences > Software AG > Service Development > Adapter
Service/Notification Editor item.

4. Enable the Automatic polling of adapter metadata option.

5. Click OK.
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Overview

Adapter for Salesforce facilitates polling of data with Salesforce.com using the adapter polling
notification templates. These templates enable a user to specify the sObjects needed to poll
Salesforce.com at specified periodic intervals for any changes in the organization's data. This
essentially includes creating, updating, and deleting records. The adapter uses the data replication
APIs provided by Force.comWeb services, getUpdated() and getDeleted(), to implement the
polling notification.

Before you configure Adapter for Salesforce polling notifications, you must configure the
connections you plan to use with them. See “Configuring Adapter Connections” on page 56 for
details.

For a description of adapter polling notifications, see “Adapter Polling Notifications” on page 21.

If you are using the adapter in a clustered environment, you will need to configure the polling
notifications so that they run effectively. For more information, see “Polling Notification Support
in Integration Server Clusters” on page 48.

Before Configuring Adapter Polling Notifications

Before you configure a Adapter for Salesforce polling notification

1. Start your Integration Server and Integration Server Administrator, if they are not already
running.

2. Make sure you have Integration Server administrator privileges so that you can access the
Adapter for Salesforce administrative screens. For information about setting user privileges,
see the webMethods Integration Server Administrator’s Guide for your release.

3. Using Integration Server Administrator, make sure the WmSalesforceAdapter package is
enabled. For instructions, see “Enabling and Disabling Packages” on page 41.

4. Using Integration ServerAdministrator, configure an adapter connection to usewith the polling
notification. See “Configuring Adapter Connections” on page 56 for instructions.

5. Start Software AG Designer if it is not already running.

Note:
Use the Service Development perspective in Designer. For more information, see the
webMethods Service Development Help for your release.

6. Using Designer, create a user-defined package to contain the polling notification, if you have
not already done so. When you configure adapter notifications, you should always define
them in user-definedpackages. Formore information aboutmanaging packages for the adapter,
see “Managing the Adapter Package” on page 40.

106 webMethods Adapter for Salesforce Installation and User’s Guide 8.2

6 Adapter Polling Notifications



Note:
You must schedule and enable a polling notification before you can use it.

Configuring Adapter Polling Notifications

The polling notification template is designed to work on a single Salesforce object at a time. The
object must be replicable (that is, the replicateable field for the Object must be set to "true"; for
more information, see the Force.com Web Services API Developer's Guide). Adapter for Salesforce
defines two polling notification templates, one for capturing any create or update changes and
another for any records deleted.

Adapter for Salesforce uses the getUpdated() call to implement Upsert Notifications and
getDeleted() call for DeleteNotifications. The call takes three input parameters: startDate, endDate
and sObject as explained below:

startDate: The initial start date is calculated by the polling notification based on the day count
parameter provided by the user. For subsequent calls, the start date is used as the
latestDateCovered from the previous notification.

endDate: The current date is used as the end date by the polling notification.

sObject: The object selected by the user during creation of the polling notification.

Creating an Upsert Polling Notification
AnUpsert Notification publishes an output document containing the IDs of the updated sObjects
for the given time interval.

To configure an Upsert polling notification

1. Review the steps in “Before Configuring Adapter Polling Notifications” on page 106.

2. Start Designer.

3. Right-click the package inwhich the notification should be contained and selectNew > Adapter
Notification.

4. Select the parent namespace, type a name for the adapter notification, and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select Upsert Notification as the Template Name and click Next.

7. Select the appropriateAdapter Connection Name and clickNext. This specifies the connection
that the notification will use to connect to the Salesforce.com resource.

8. The name of the publishable document associatedwith this notification displays. ClickFinish.
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9. The editor for the adapter notification appears. The tabs that appear on the editor are explained
below:

Upsert Polling: This tab enables you to configure the notification. There are two fields on
this tab.

DayCount: The notification uses the value in this field to calculate the initial start date
when the notification runs. The value must be between 1 and 30 days.

Salesforce object: This field identifies the object type for which the create or update
notification is required. When the notification is created, Upsert notification does the
validation check to ensure that the sObject is replicable.

Adapter Settings: Select this tab to confirm adapter service properties such as theAdapter
Name, Adapter Connection Name, and Adapter Notification Template, as necessary.

Output Fields: This tab displays the output that will be used by ART for creating the
document to be published.

id[ ]: Array of IDs of each object that has been updated.

latestDateCovered: The timestamp of the process when the records are fetched from
Salesforce within the range startdate and enddate.

Permissions: This tab is provided by ART and contains user-specified permissions for
notifications. For information about using the Permissions tab to assign an access control
list (ACL) to an element, see the webMethods Service Development Help for your release.

Make the appropriate selections on these tabs for your notification.

10. From the File menu, select Save to save your settings.

11. After you create a polling notification using Designer, you must open that notification in
Integration Server Administrator to schedule and enable it. See “Managing Polling
Notifications” on page 110 for information about scheduling and enabling a polling notification.

Creating a Delete Polling Notification
A Delete Notification publishes an output document containing the IDs of the deleted sObjects
for the given time interval.

To configure a Adapter for Salesforce Delete polling notification

1. Review the steps in “Before Configuring Adapter Polling Notifications” on page 106.

2. Start Designer.

3. Right-click the package inwhich the notification should be contained and selectNew > Adapter
Notification.
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4. Select the parent namespace, type a name for the adapter notification, and click Next.

5. Select Salesforce.com Adapter as the adapter type and click Next.

6. Select Delete Notification as the Template Name and click Next.

7. Select the appropriateAdapter Connection Name and clickNext. This specifies the connection
that the notification will use to connect to the Salesforce.com resource.

8. The name of the publishable document associatedwith this notification displays. ClickFinish.

9. The editor for the adapter notification appears. The tabs that appear on the editor are:

Delete Polling: This tab enables you to configure the notification. There are two fields on
this tab.

DayCount: The notification uses the value in this field to calculate the initial start date
when the notification runs. The value must be between 1 and 30 days.

Salesforce object: This field identifies the object type for which the delete notification
is required. When the notification is created, Delete notification does the validation
check to ensure that the sObject is replicable.

Adapter Settings: Select this tab to confirm adapter service properties such as theAdapter
Name, Adapter Connection Name, and Adapter Notification Template, as necessary.

Output Fields: This tab displays the output that will be used by ART for creating the
document to be published.

deleteRecords[ ].id: The ID of the record that has been deleted.

deleteRecords[ ].deleteDate: The date when the object was deleted.

latestDateCovered: The timestamp of the process when the records are fetched from
Salesforce within the range startdate and enddate.

Permissions: This tab is provided by ART and contains user-specified permissions for
notifications. For information about using the Permissions tab to assign an access control
list (ACL) to an element, see the webMethods Service Development Help for your release.

Make the appropriate selections on these tabs for your notification.

10. From the File menu, select Save to save your settings.

After you create a polling notification usingDesigner, youmust open that notification in Integration
ServerAdministrator and schedule and enable it. See “Managing PollingNotifications” on page 110
for information about scheduling and enabling a polling notification.
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Managing Polling Notifications

You must schedule a polling notification and then enable it before you can use the notification.
Use Integration Server Administrator along with the following procedures to do so.

Note:
You must have Integration Server administrator privileges to access the Adapter for Salesforce
administrative screens. For information about setting user privileges, see the webMethods
Integration Server Administrator’s Guide for your release.

To manage polling notifications

1. In Integration Server Administrator, select Adapters>Adapter for Salesforce.

2. From the navigation area, select Polling Notifications.

3. From the Polling Notifications table, provide values for the following fields for each adapter
polling notification:

Description/ActionField

The name of the notification.Notification Name

The name of the package for the notification.Package Name

Note:
You must schedule a polling notification before you can enable it. To
schedule a polling notification, click the icon described in these
procedures.

Enabled

After you schedule a polling notification, you can use this option to
enable (Yes)or disable (No) a polling notification. Click on the current
value in this field to change its value.

Enabling and disabling a notification affects how its trigger is created
and dropped. For details, see “Polling Notification Types” on page 22.

If there is no polling notification scheduled for a given adapter
notification, Not Scheduledappears in this field.Click the icon to
create a polling notification as described in step 4.

Click the icon to create or modify polling notification parameters.Edit Schedule

Note:
You must disable a polling notification before you can edit it.

Continue to step 4.
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Description/ActionField

Click on the View Schedule icon to review the parameters for the
selected polling notification. ClickReturn to Adapter 8.2 for Salesforce
Notifications to go back to the main polling notification page.

View Schedule

4. To create or modify schedule parameters for the selected adapter polling notification, click the
icon and provide values for the following fields:

Description/ActionField

Type the polling interval time in seconds.Interval (seconds)

Note:
Do not use this option; otherwise, when you enable this notification,
it may lock up tables and cause Integration Server to fail.

Overlap

Enable this option to start polling immediately.Immediate

5. Click Save Schedule.

6. After you create a polling notification, you can enable it. Use the Enabled field described in
step 3 to enable a polling notification.

Exporting Configured Adapter Polling Notifications

You can export polling notifications from one Integration Server to another Integration Server.
You do not need to disable notifications in order to export them. In most cases, the current state
of the notifications in the package that you export is retained.However, if you deploy to a different
Integration Server and connect to a different database, then you should first disable the notification.

Note:
A given notification can run on only one Integration Server at a time.

The start date of the polling notification is stored in the shared cache location.When the notifications
are exported, if the notification is unable to fetch the start date from the cache, the start date for
the first notification will be calculated based on the day count configured for the adapter polling
notification. When Integration Server with the exported notifications starts, each configured
notification starts to poll the changed data from Salesforce.com.

If you want to export configured polling notifications in a disabled state, you need to disable the
notifications before you export the package containing them. To enable or disable a polling
notification, see “Managing Polling Notifications” on page 110.

For more information about Insert Notifications, Update Notifications, or Delete Notifications,
see “Polling Notification Types” on page 22.
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Formore information about exporting packages, see thewebMethods Integration ServerAdministrator’s
Guide for your release.

Viewing Polling Notifications

You use Designer to view polling notifications.

To view a polling notification

1. Review the steps in “Before Configuring Adapter Polling Notifications” on page 106.

2. In Designer, expand the package and folder that contain the polling notification you want to
view.

3. Double-click the notification you want to view.

Designer displays the notification in the notification template's Adapter Notification Editor.

Editing Polling Notifications

You use Designer to edit polling notifications.

To edit a polling notification

1. Review the steps in “Before Configuring Adapter Polling Notifications” on page 106.

2. In Designer, expand the package and folder that contain the polling notification you want to
edit.

3. Select the notification you want to edit.

Designer displays the notification in the notification template's Adapter Notification Editor.

4. Do one of the following:

If you have the VCS Integration feature enabled, right-click the polling notification and
select Check Out.

If you do not have the VCS Integration feature enabled, right-click the polling notification
and select Lock for Edit.

If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check out the polling notification. The options available
in the Team menu depend on the VCS client that you use.
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5. Modify the values for the polling notification's parameters as needed. For detailed descriptions
of the notification's parameters, see “Configuring Adapter Polling Notifications” on page 107
for the specific type of notification you want to edit.

Note:
When you edit a notification, all the parameters in the adapter notification are reset.

6. After you complete yourmodifications, save the polling notification anddo one of the following:

If you have the VCS Integration feature enabled, right-click the notification and select
Check In. Enter a check-in comment and click OK.

If you do not have the VCS Integration feature enabled, right-click the notification and
select Unlock.

If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check in the notification. The options available in the Team
menu depend on the VCS client that you use.

Deleting Polling Notifications

You use Designer to delete adapter polling notifications.

Note:
Before you delete the notification, be sure that you first disable it. To disable a polling notification,
see “Managing Polling Notifications” on page 110.

To delete a polling notification

1. Review the steps in “Before Configuring Adapter Polling Notifications” on page 106.

2. In Designer, expand the package and folder that contain the polling notification you want to
delete.

3. Right-click the notification and click Delete.

Validating Polling Notification Values

Designer enables Adapter for Salesforce to validate user-defined data for adapter polling
notifications at design time. You can validate the values for a single notification or you can configure
Designer to always validate the values for polling notifications. Both options could potentially
slow your design-time operations.

When you enable data validation for a single adapter polling notification, Designer compares the
notification values against the resource data that has already been fetched from the selected adapter.

If you select the option to always validate values for adapter polling notifications, it will do so for
all webMethods WmART-based adapters installed on Integration Server.
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For more information about the Adapter Service/Notification Editor, other Designer menu
options, and toolbar icons, see the webMethods Service Development Help for your release.

Validating Values for a Single Adapter Service

To validate adapter polling notification values for a single adapter service

1. Review the steps in “Before Configuring Adapter Polling Notifications” on page 106.

2. In Designer, expand the package and folder that contain the polling notification for which you
want to enable automatic validation.

3. Double-click the notification for which you want to validate the data.

Designer displays the configured adapter notification in the service template's Adapter
Notification Editor.

4. Click the icon.

Validating Values for All Polling Notifications

To validate adapter notification values for all polling notifications

1. Review the steps in “Before Configuring Adapter Polling Notifications” on page 106.

2. Start Designer.

3. Select the Window > Preferences > Software AG > Service Development > Adapter
Service/Notification Editor item.

4. Enable the Automatic data validation option.

5. Click OK.

Reloading Adapter Values

Designer enables Adapter for Salesforce to reload and validate user-defined data for polling
notifications at design time. You can reload values for a single notification or you can configure
Designer to always validate the values for notifications. Both options could potentially slow your
design-time operations.

When you reload adapter values for a single polling notification,Designer compares the notification
values against the resource data that has already been fetched from the selected adapter.
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If you select the option to always reload values for adapter polling notifications, it will do so for
all webMethods WmART-based adapters installed on Integration Server.

For more information about the Adapter Service/Notification Editor, other menu options, and
toolbar icons, see the webMethods Service Development Help for your release.

Reloading Values for a Single Adapter Polling Notification

To reload the adapter values for a single adapter polling notification

1. Review the steps in “Before Configuring Adapter Polling Notifications” on page 106.

2. In Designer, expand the package and folder that contain the service for which you want to
enable automatic validation.

3. Double-click the service for which you want to validate the data.

Designer displays the configured adapter service in the service template's AdapterNotification
Editor.

4. Click the icon.

Reloading Values for All Adapter Notifications

To automatically reload the values for all adapter notifications

1. Review the steps in “Before Configuring Adapter Polling Notifications” on page 106.

2. Start Designer.

3. Select the Window > Preferences > Software AG > Service Development > Adapter
Service/Notification Editor item.

4. Enable the Automatic polling of adapter metadata option.

5. Click OK.
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Listeners

This section describes how to create and manage Adapter for Salesforce listeners.

Before Configuring New Listeners

To prepare to configure a new listener

1. Start Integration Server and Integration Server Administrator, if they are not already running.

Important:
Make sure that you have webMethods administrator privileges so that you can access the
adapter’s administrative screens. For information about setting user privileges, see the
webMethods Integration Server Administrator’s Guide for your release.

2. Using Integration Server Administrator, make sure that the WmSalesforceAdapter package is
enabled. To verify the status of theWmSalesforceAdapter package, see “Enabling andDisabling
Packages” on page 41.

3. Using Software AGDesigner, create a user-defined package to contain the listener, if you have
not already done so. For more information about managing packages, see Adapter Package
Management.

4. Using Integration Server Administrator, configure a valid Salesforce.com OAuth connection.
Formore information about configuring Salesforce.comOAuth connections, see “Configuring
a Salesforce.com OAuth Connection” on page 60.

Configuring an Adapter Listener

To configure a Adapter for Salesforce listener

1. In Integration Server Administrator, select Adapters>Adapter for Salesforce.

2. In the Adapter for Salesforce menu, select Listeners.

3. On the Listeners screen, select Configure New Listener.

4. On the Listener Types screen, select Single Topic Listener.

5. On the Configure Listener Type screen, configure the following fields:

Description/ActionParameter

The package in which to create the listener.Package
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Description/ActionParameter

Create the listener in a user-defined package
rather than in the adapter's package. For other
considerationswhen creating packages for the
adapter, see Adapter Package Management.

You must create the package using Designer
before you can specify the package by using
this parameter. For general information about
creating packages, see the webMethods Service
Development Help for your release.

The folder in which to create the listener.Folder Name

The name of the new listener.Listener Name

The name of the Salesforce.com OAuth
connection to associate with the listener.

Connection Name

From the list of connections, select an
appropriate Salesforce.comOAuth connection
that you created on theConfigureConnections
Type screen.

Important:
Youmust use a valid Salesforce.comOAuth
connectionwith a listener. If you do not use
a valid Salesforce.com OAuth connection,
enabling the listener will return an error.

The number of times that the adapter tries to
reconnect, if the adapter fails to connect to or

Retry Limit

loses connectionwith Salesforce.com.Default:
5

The number of seconds that elapse between
each of the retries specified in the retry limit.
Default: 10

Retry Backoff Timeout

Important:
The listener name is prefixed by the folder name and is separated by a colon. For example,
if the folder name is "Folder1" and the listener name is "Listener1", the listener name in the
Listeners screen will be "Folder1:Listener1".

6. In the Listener Properties section, configure the following fields:
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Description/ActionParameter

The Force.comStreamingAPI endpoint URI.
The default endpoint is:

Push EndPoint

/cometd/25.0

For more information about the parameter,
see the Force.com Streaming API
documentation.

The Streaming API channel to which the
listener subscribes. The push topic is the basis

Push Topic

for notifying listeners of any changes to the
specified Salesforce.com records and objects.

For more information about push topics and
about how to create them, see the Force.com
Streaming API documentation.

The number of times the listener tries to
connect to Salesforce.com in case of an error
or exception. The default is 5.

Handshake Retry

The time in milliseconds after which the
listener tries to reconnect to Salesforce.com

Handshake Retry Interval(ms)

in case of an error or exception. The default
is 1000.

The number of milliseconds that the listener
waits for a response from Salesforce.com

HTTP Connect Timeout(ms)

before the connection times out. The default
is 30000.

The idle timeout in milliseconds after which
the request that the listener sent to
Salesforce.com expires. The default is 60000.

HTTP Idle Timeout(ms)

The number of milliseconds before a
handshake with Salesforce.com times out.
The default is 10000.

Handshake Timeout(ms)

Enabling Listeners
Before you enable a listener, you need to configure one or more notifications to associate with the
listener. If no notifications are configured when you enable the listener, Integration Server
Administrator displays a warning message.

After you configure your notifications, you must enable the listener so that the associated
notifications communicate appropriately with the listener at run time. You enable the listeners
using Integration Server Administrator.
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The Status column indicates the readiness of the listener. If the status is Succeeded, the listener
is ready to be enabled. If the status is Failed, an error occurred during startup. If an error occurs
during startup, the state will not change to Enabled when refreshing the page. Errors at this stage
typically indicate a problem with either the listener configuration or the network. Review the
listener settings and check the network.

For more information about configuring listeners and listener notifications, see “Configuring an
Adapter Listener” on page 118 and “Configuring Listener Notifications” on page 128.

Note:
When you reload a package that contains enabled listeners, the listeners will automatically be
enabled when the package reloads. If the package contains listeners that are disabled, they will
remain disabled when the package reloads.

To enable a listener

1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. In the Adapter for Salesforce menu, select Listeners. The Listeners screen appears.

3. Select Enabled from the drop-down list in the State field. Integration Server Administrator
enables the listener.

The Enable all suspended link helps you change the state quickly for multiple listeners.

Testing Listeners
You can test listeners to ensure that you configured them correctly.

To test a listener

1. Configure a listener using Integration Server Administrator. For instructions on how to
configure a listener, see “Configuring an Adapter Listener” on page 118.

2. Configure a listener notification using Designer. For instructions on how to configure a
notification, see “Configuring Listener Notifications” on page 128.

3. Enable the listener notification using Integration Server Administrator. For instructions on
how to enable a listener notification, see “Enabling Listener Notifications” on page 132.

4. Enable the listener using Integration Server Administrator. For instructions on how to enable
a listener, see “Enabling Listeners” on page 120.

5. Make a change in your backend system to activate the listener.
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The listener searches for filters and returns messages that match the filter criteria that you
specified when you configured the listener on the Configure Listener Type screen. Filtered
messages are then sent to the listener notification for further processing.

For more information on how listeners and listener notifications work at run time, see “Run-
Time Processing of Listeners and Listener Notifications” on page 29.

Viewing Listener Parameters
You can view a listener's parameters from Integration Server Administrator and Designer. You
can also view the notification order of a listener.

Viewing Listener Parameters Using Integration Server Administrator

To view a listener's parameters using Integration Server Administrator

1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. In the Adapter for Salesforce menu, select Listeners.

When using the adapter with Integration Server 8.2 and later, you can sort and filter the list
of listeners that appears on the Listeners screen.

To sort information on the Listeners screen, click the Up and Down arrows at the top of
the column that you want to sort.

To filter the list of listeners:

1. On the Listeners screen, click Filter Listeners.

2. Type the criterion by which you want to filter into the Filter criteria box. Filtering is
based on the node name, not the listener name. To locate all listeners containing specific
alphanumeric characters, use asterisks (*) as wildcards. For example, if you want to
display all listeners containing the string "abc", type *abc* in the Filter criteria box.

3. ClickSubmit. The Listeners screen displays the connections thatmatch the filter criteria.

4. To re-display all listeners, click Show All Listeners.

The Listeners screen appears, listing all the current listeners. You can control the number
of listeners that are displayed on this screen. For more information, see “Controlling
Pagination” on page 31.

3. On the Listeners page, click the icon for the listener that you want to see.

The View Listener screen displays the parameters for the listener. For descriptions of the
listener parameters, see “Configuring an Adapter Listener” on page 118.

4. Click Return to Adapter for Salesforce Listeners to return to the main listeners screen.
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Viewing Listener Parameters Using Designer

To view a listener’s parameters using Designer

1. Review the steps in “Before Configuring New Listeners” on page 118.

2. From Designer, expand the package and folder in which the listener is located.

3. Double-click the listener that you want to view.

The parameters for the listener appear on the Listener Information tab. For descriptions of
the listener properties, see “Configuring an Adapter Listener” on page 118.

Viewing the Notification Order of a Listener

To view the notification order of a listener

1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. In the Adapter for Salesforce menu, select Listeners.

3. On the Listeners screen, click the icon for the listener that youwant to view. TheViewListener
screen appears.

4. On the View Listener screen, select View Notification Order.

The View Notification Order screen displays the order of the notifications for the listener.

5. Click Return to View Listener to return to the View Listeners screen.

Editing Listeners
You use Integration Server Administrator to edit a listener in the following situations:

If you need to select a newly configured connection, or if you need to change any listener
properties, such as filter values, you can update the listener parameters.

If you need to change the order of the notifications that are associated with the listener. For
more information, see “Editing the Notification Order of a Listener” on page 124.

To edit a listener

1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. In the Adapter for Salesforce menu, select Listeners.
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3. On the Listeners screen, make sure that the listener is disabled before editing. To disable the
listener, see “Disabling Listeners” on page 126.

4. On the Listeners screen, click the icon for the listener that you want to edit.

The Edit Listener screen displays the current parameters for the listener. Update the listener's
parameters by typing or selecting the values you want to specify.

For descriptions of the listener parameters, see “Configuring anAdapter Listener” on page 118.

5. Click Save Changes to save the listener and return to the Listeners screen.

Editing the Notification Order of a Listener

To edit the notification order of a listener

1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. In the Adapter for Salesforce menu, click Listeners.

3. On the Listeners screen, make sure that the listener is disabled before editing. To disable the
listener, see “Disabling Listeners” on page 126.

4. On the Listeners screen, click the icon for the listener that you want to edit.

5. On the Edit Listener screen, select Edit Notification Order.

6. On the EditNotificationOrder screen, use theUp andDown buttons to determine the processing
order in which the adapter invokes the notifications.

Note:
For better processing results, arrange your notifications from ascending to descending order
starting with the most detailed notifications to the least detailed notifications.

7. Click Save Changes.

8. Click Return to Edit Listener to return to the Edit Listener screen.

Copying Listeners
You can copy an existing listener to create a new listener with the same or similar properties
without having to type or specify all properties for the listener. You copy adapter listeners using
Integration Server Administrator.

To copy a listener
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1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. In the Adapter for Salesforce menu, select Listeners.

3. On the Listeners screen, click the icon for the listener that you want to copy.

The Copy Listener screen displays the current parameters for the listener that you want to
copy. Name the new listener and edit any listener parameters as needed by typing or selecting
the values you want to specify.

For descriptions of the listener parameters, see “Configuring anAdapter Listener” on page 118.

4. Click Save Changes to save the listener and return to the Listeners screen.

Deleting Listeners
If you no longer want to use a listener, you can delete the listener. You use Integration Server
Administrator to delete listeners.

Important:
If you delete aAdapter for Salesforce listener, any notifications that are defined to use the listener
will no longer work. You cannot change which listener a notification uses after the notification
is configured.However, you can change the parameters for an existing listener. For instructions,
see “Editing Listeners” on page 123.

To delete a listener

1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. In the Adapter for Salesforce menu, select Listeners.

3. On the Listeners screen, make sure that the listener is disabled. To disable the listener, see
“Disabling Listeners” on page 126.

4. On the Listeners screen, click for the listener you want to delete.

Integration Server deletes the listener.

Suspending Listeners
You must be running Integration Server to suspend a listener.

When you suspend a listener, the action may not take effect right away. You may have to wait as
long as the time specified in the Timeout parameter for the listener. If one ormoremessages appear
on the topic within that time interval, the adapter may receive and process the first message.

Note:
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In Adapter for Salesforce, a suspended listener behaves identically to a disabled listener.

To suspend a listener

1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. In the Adapter for Salesforce menu, select Listeners.

3. On the Listeners screen, select Suspended from the drop-down list in the State column.
Integration Server Administrator suspends the listener.

The Suspend all enabled link helps you change the state quickly for multiple listeners.

Disabling Listeners
Listenersmust be disabled before you can edit or delete them. Youdisable listeners using Integration
Server Administrator.

When you disable a listener, the action may not take effect right away. You may have to wait as
long as the time specified in the Timeout parameter for the listener. If one ormoremessages appear
on the topic within that time interval, the adapter may receive and process the first message.

Note:
In Adapter for Salesforce, a disabled listener behaves identically to a suspended listener.

To disable a listener

1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. In the Adapter for Salesforce menu, select Listeners.

3. On the Listeners screen, select Disabled from the drop-down list in the State column.
Integration Server Administrator disables the listener.

Listener Notifications

Adapter for Salesforce has two types of listener notifications that you can configure:

Asynchronous Listener Notifications

Synchronous Listener Notifications

For more information on how listener notifications work, see “Listener Notifications” on page 27.

Process Overview
The following table lists the tasks required to use asynchronous and synchronous notifications:
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Use this toolTask

Integration Server AdministratorConfigure a Salesforce.comOAuth connection.
For instruction on configuring a Salesforce.com

1

OAuth connection, see “Configuring a
Salesforce.comOAuthConnection” on page 60.

Integration Server AdministratorConfigure an adapter listener using the
Salesforce.com OAuth connection. For

2

instruction on configuring a listener, see
“Configuring anAdapter Listener” onpage 118.

DesignerSelect the appropriate listener notification
template and configure the notification. For

3

instructions on configuring listener
notifications, see “Configuring Listener
Notifications” on page 128.

DesignerIf you plan to use an Integration Server flow or
Java service, design the service to react to the

4

data changes contained in the listener
notification's publishable document. Configure
an Integration Server trigger to use the
notification's publishable document. For
instructions on configuring notifications, see
the webMethods Service Development Help for
your release.

To process the message from the topic, you
should create an Integration Server trigger that
subscribes to the Integration Server document
type that Adapter for Salesforce created with
the asynchronous listener notification. Formore
information about using triggers, see the
Publish-Subscribe Developer’s Guide for your
release.

Integration Server AdministratorEnable the listener notifications. For instructions
on how to enable listener notifications, see
“Enabling Listener Notifications” on page 132.

5

Before Configuring Listener Notifications

To prepare to configure a listener notification

1. Start Integration Server and Integration Server Administrator, if they are not already running.

Note:
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Make sure that you have webMethods administrator privileges so that you can access
Adapter for Salesforce’s administrative screens. For information about setting user privileges,
see the webMethods Integration Server Administrator’s Guide for your release.

2. Using Integration Server Administrator, make sure that the WmSalesforceAdapter package is
enabled. To verify the status of theWmSalesforceAdapter package, see “Enabling andDisabling
Packages” on page 41.

3. Configure a listener using Integration Server Administrator. For more information on how to
configure a new listener, see “Configuring an Adapter Listener” on page 118.

4. Using Designer, create a user-defined package in which to contain the listener, if you have not
already done so. For more information about managing packages, see Adapter Package
Management.

Configuring Listener Notifications
Adapter for Salesforce has two types of listener notifications that you can configure:

Asynchronous Listener Notifications

Synchronous Listener Notifications

You configure listener notifications usingDesigner. For a description of the adapter’s asynchronous
and synchronous listener notifications, see “Listener Notifications” on page 27.

Configuring an Asynchronous Listener Notification

To configure an asynchronous listener notification

1. Review the steps in “Before Configuring Listener Notifications” on page 127.

2. Start Designer.

3. Right-click the package in which the listener notification should be contained and select New
> Adapter Notification.

4. Select the parent namespace, type a name for the adapter listener notification, and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select Async Listener Notification as the template and click Next.

7. Select the appropriate Notification Listener Name and click Next.

8. Click Finish.
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Designer creates an asynchronous listener notification and an asynchronous publishable
document type, and the editor for the adapter notification appears.

9. On the Async Notification tab, select a push topic from the drop-down list in the Pushtopic
Name field and click Save.

Important:
You should select a Pushtopic Name that matches the push topic to which the listener that
you associated with the listener notification is subscribed. Selecting a different Pushtopic
Name will result in an error.

When you select a Pushtopic Name, an sObject parameter appears in the asynchronous
publishable document type. For each PushtopicName, the parameters that the sObject contains
match the SOQL query that the push topic is configured with.

10. To specify how you want the listener notification document to be published, in the Publish
Document section on the Adapter Settings tab do one of the following:

To publish documents to a Broker, select webMethods Broker/Local. This is the default
option.

To publish documents to a JMS provider, select JMS Provider, and provide values for the
following input fields:

DescriptionField

Specifies the name of the JMS connection alias
configured on Integration Server.

Connection alias name

If the connection alias is a Broker Cluster configured
with Multisend Guaranteed policy, you must add
the watt property
watt.art.notification.jmsSend.usePublicService and set it to
true.

Note:
Adapter Runtime does not support
LOCAL_TRANSACTION and
XA_TRANSACTION type JMS connection alias.

Specifies the name of the destination fromwhich you
want the JMS trigger to receive messages.

Destination name

Specifies whether the destination is a Queue (default)
or a Topic.

Destination type

You can select theAdapter Settings tab at any time to confirma listener notification’s properties
such as the Adapter Name, Adapter Listener Name, and Adapter Notification Template as
necessary.
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Configuring a Synchronous Listener Notification

To configure a synchronous listener notification

1. Review the steps in “Before Configuring Listener Notifications” on page 127.

2. Start Designer.

3. Right-click the package in which the listener notification should be contained and select New
> Adapter Notification.

4. Select the parent namespace, type a name for the adapter listener notification, and click Next.

5. Select Adapter for Salesforce as the adapter type and click Next.

6. Select Sync Listener Notification as the template and click Next.

7. Select the appropriate Notification Listener Name and click Next.

8. Select the appropriate Service Node and click Next.

9. Click Finish.

The Adapter Notification template creates the following items:

A Synchronous Listener Notification

Two Synchronous Document Types:

A Synchronous Reply Document Type

A Synchronous Request Document Type

10. On the Sync Notification tab, select a push topic from the drop-down list in the Pushtopic
Name field and click Save.

Important:
You should select a Pushtopic Name that matches the push topic to which the listener that
you associated with the listener notification is subscribed. Selecting a different Pushtopic
Name will result in an error.

When you select a Pushtopic Name, an sObject parameter appears in the Request Document
Type. For each Pushtopic Name, the parameters that the sObject contains match the SOQL
query that the push topic is configured with.

11. Select the Adapter Settings tab to view the adapter properties and to select the appropriate
service name for the synchronous notification.
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The following fields in the Adapter Properties section are read-only:

DescriptionAdapter Properties

The name of the adapter.Adapter Name

The name of the adapter listener that you selected when
you configured the synchronous notification.

Adapter Listener Name

The name of the adapter notification template that you
selectedwhen you configured the synchronous notification.

Adapter Notification Template

12. Specify one of the following modes in the Execution Mode section:

To invoke a flow service directly, select Service Invoke and specify the following field:

DescriptionProperty

The name of the service, which you selected when
you initially configured the adapter listener
notification, appears in the Service Name field.

Service Name

Important:
Before you select a different service,make sure that
you have disabled the listener notification. When
the notification is enabled, the new service is used.
For more information on enabling and disabling
listener notifications, see “Enabling Listener
Notifications” on page 132 and “Disabling Listener
Notifications” on page 135.

To publish documents locally or to a Broker and wait for a reply, select Publish and Wait
and specify the following fields:

DescriptionProperties

Select true to publish documents locally (to the
running Integration Server only) or false to publish
to the Broker connected to the Integration Server.

Local

Note:
If no Broker is configured for Integration Server,
documents will be published locally.

Specify the number of milliseconds to wait for a
reply. The default is -1, which means to wait
indefinitely.

Wait Time
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Enabling Listener Notifications
After you configure a listener notification, you need to enable it using Integration Server
Administrator.

To enable a listener notification

1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. In the Adapter for Salesforce menu, select Listener Notifications.

3. On the ListenerNotifications screen, clickNo in theEnabled column for the listener notification
that you want to enable.

Integration Server Administrator enables the listener notification and displays a and Yes in
the Enabled column.

Testing Listener Notifications

To test a listener notification

1. Configure a listener using Integration Server Administrator. For instructions on how to
configure a listener, see “Configuring an Adapter Listener” on page 118.

2. Configure a listener notification using Designer. For instructions on how to configure a
notification, see “Configuring Listener Notifications” on page 128.

3. Enable the listener notification using Integration Server Administrator. For instructions on
how to enable a listener notification, see “Enabling Listener Notifications” on page 132.

4. Enable the listener using Integration Server Administrator. For instructions on how to enable
a listener, see “Enabling Listeners” on page 120.

5. Make a change in your backend system to activate the listener.

The listener searches for, filters, and returns messages that match the filter criteria that you
specified when you configured the listener on the Configure Listener Type screen. Filtered
messages are then sent to the listener notification for further processing.

For more information on how listeners and listener notifications work at run time, see “Run-
Time Processing of Listeners and Listener Notifications” on page 29.
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Testing Publishable Document Types
You can test a publishable document type that is associated with an asynchronous notification in
Designer. When you test a publishable document type, you provide input values that Designer
uses to create an instance of the publishable document type. You also specify a publishingmethod
(such as publish, publish and wait, deliver, or deliver and wait). Designer then publishes a
document and displays the results of the publish operation in the Results dialog box.

Testing a publishable document type provides a way for you to publish a document without
building a service that does the actual publishing. If you select a publication action where you
wait for a reply document, you can verify whether or not reply documents are received.

For instructions on how to test a publishable document type, see the Publish-Subscribe Developer’s
Guide and webMethods Service Development Help for your release.

Viewing Listener Notifications

To view a listener notification

1. Review the steps in “Before Configuring Listener Notifications” on page 127.

2. In Designer, expand the package and folder that contain the listener notification that youwant
to view.

3. Select the listener notification that you want to view.

Designer displays the configured listener notification in the adapter's Adapter Notification
Editor.

Editing Listener Notifications
You use Designer to edit synchronous and asynchronous listener notifications. You can also edit
the publishable document type associated with an asynchronous listener notifications. However,
you cannot edit the request and reply document types that are associatedwith synchronous listener
notifications.

Listener notifications must be disabled before you can edit them.

To edit a listener notification

1. Review the steps in “Before Configuring Listener Notifications” on page 127.

2. In Designer, expand the package and folder that contain the listener notification that youwant
to edit.

3. Select the listener notification that you want to edit.
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Designer displays the configured listener notification in the adapter's Adapter Notification
Editor.

4. Do one of the following:

If you have the VCS Integration feature enabled, right-click the notification and select
Check Out.

If you do not have the VCS Integration feature enabled, right-click the notification and
select Lock for Edit.

If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check out the notification. The options available in the
Team menu depend on the VCS client that you use.

5. Open the listener notification and modify the notification's parameter values as needed. For
detailed descriptions of the listener notification’s parameters, see “Configuring Listener
Notifications” on page 128.

6. After you complete themodifications, save the listener notification and do one of the following:

If you have the VCS Integration feature enabled, right-click the notification and select
Check In. Enter a check-in comment and click OK.

If you do not have the VCS Integration feature enabled, right-click the notification and
select Unlock.

If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check in the notification. The options available in the Team
menu depend on the VCS client that you use.

Editing Publishable Document Types
You use Designer to edit the publishable document type associated with asynchronous listener
notifications.

To edit an asynchronous publishable document type

1. Review the steps in “Before Configuring Listener Notifications” on page 127.

2. In Designer, expand the package and folder that contain the asynchronous publishable
document type that you want to edit.

3. Select the asynchronous publishable document type that you want to edit.

Designer displays the configured asynchronous publishable document type in the adapter's
Adapter Listener Editor.
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4. Select thePublication Properties tab andmodify the available values for the document type's
parameters as needed. For a description of the asynchronous document type's parameters, see
“Configuring an Asynchronous Listener Notification” on page 128.

Deleting Listener Notifications
If you no longerwant to use a particular Adapter for Salesforce listener notification, you can delete
it. You delete listener notifications, both synchronous and asynchronous, using Designer.

Important:
If you delete a synchronous listener notification, the associated request and reply document
types are automatically deleted. If you delete an asynchronous listener notification, the associated
publishable document type is automatically deleted. You cannot individually delete the document
types associated with synchronous and asynchronous listener notifications.

To delete a listener notification

1. Review the steps in “Before Configuring Listener Notifications” on page 127.

2. In Designer, expand the package and folder that contain the listener notification that youwant
to delete.

3. Right-click the listener notification and click Delete.

Disabling Listener Notifications

To disable a listener notification

1. In Integration Server Administrator, select Adapters > Adapter for Salesforce.

2. In the Adapter for Salesforce menu, select Listener Notifications.

3. On the ListenerNotifications screen, clickYes in theEnabled column for the listener notification
that you want to disable.

The listener notification becomes disabled and you see No in the Enabled column.
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Overview

Outboundmessaging is part of the workflow rule functionality in Salesforce.com.Workflow rules
watch for specified field changes and trigger automatic sending of an outbound message. Using
the notifications() call in Salesforce.com, outbound messaging sends SOAP messages over HTTP
or HTTPS to a designated endpoint when triggered by a workflow rule.

You can configureworkflow rules in Salesforce.com so that it sends notificationswhen any changes
are made to Salesforce objects. Once a workflow rule has been associated with an outbound
message, a WSDL is created and is made available for download from the Salesforce.com user
interface. This WSDL contains the endpoint URL for the recipient of the message and the
information you want to include in the outbound message.

If you configure an outbound message, then whenever an event defined in the workflow rule is
triggered, Salesforce.com sends an outboundmessage containing the values of the specified fields
to your Integration Server. You create a web service descriptor in Integration Server using the
WSDL generated at Salesforce.com to process the outbound notification message resulting from
the workflow rule. For more information, see “Receiving Outbound Messages from
Salesforce.com” on page 24 and the webMethods Service Development Help for your release.

To ensure security, place your Integration Server behind an internal firewall and place a
webMethods Enterprise Gateway in the DMZ to allow it to accept communications and process
requests from Salesforce.com. For information related to setting up an Enterprise Gateway Server
for processing Salesforce.com notifications, see “Setting Up an Enterprise Gateway Server ” on
page 140. For detailed information about using an Enterprise Gateway Server, see the webMethods
Integration Server Administrator’s Guide for your release.

Setting Up to Receive the Outbound Messages from
Salesforce.com

This section lists the steps you perform to set up Salesforce.com to send outbound messages and
Integration Server to receive the outbound message notifications from Salesforce.com.

To set up Integration Server and Salesforce.com for outbound messaging

1. Define the outbound message and configure the workflow rule using the Salesforce.com user
interface. When you define an outbound message, Salesforce.com creates a WSDL file that is
associated with the outbound message. For more information about the steps to define the
outbound message, see the Force.com Web Services API Developer's Guide.

2. Download the WSDL file using the Salesforce.com user interface. Use this WSDL file when
creating the web service descriptor for the outbound message. For more information, see
“Downloading the WSDL for the Outbound Message” on page 139.

3. Create a web service descriptor to handle the outbound notification message resulting from
the workflow rule. The procedure to implement the web service descriptor depends on the
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version of Integration Server. For more information, see “Creating a Web Service Descriptor
in Integration Server for Receiving the Outbound Message” on page 139.

4. Set up an EnterpriseGateway Server for receiving the outboundmessages fromSalesforce.com.
For information, see “Setting Up an Enterprise Gateway Server ” on page 140.

5. Update the endpoint URL of the Salesforce.com outbound message. Specify the Enterprise
Gateway external port of the EnterpriseGateway Server as the endpoint URL for the outbound
message. For more information, see “Updating the Endpoint URL of the Salesforce.com
Outbound Message” on page 141.

Downloading the WSDL for the Outbound Message

After defining the outbound message and the workflow rules in Salesforce.com, Salesforce.com
creates a WSDL that is associated with the message. This section lists the steps to download the
WSDL file using the Salesforce.com user interface. Use this WSDL file when creating the web
service descriptor for the outbound message.

To obtain the WSDL for the outbound message

1. In the Salesforce.com user interface, go to Setup > Create > Workflow & Approvals >
Outbound Messages.

2. On the All Outbound Messages page, click the name of the message for which you want to
create a service.

3. In the Endpoint WSDL field, click Click for WSDL to display the WSDL.

4. Save the WSDL to your file system. You will use this WSDL when creating the web service
descriptor that handles the outbound messages.

5. For more information on how to download the WSDL file, see the Force.com Web Services API
Developer's Guide.

Creating a Web Service Descriptor in Integration Server for
Receiving the Outbound Message

In Integration Server, you can create a web service descriptor for the outbound message from
Salesforce.com.

To create the web service descriptor that processes the outbound message in Integration
Server

1. Create a provider web service descriptor using the WSDL file from Salesforce.com.
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a. In Designer, select File > New.

b. Select Web Service Descriptor and click Next.

c. On the Web Description Window, select the following and click Next.

For Create Web service descriptor as, select Provider.

For Web service source, select WSDL URL. Click Browse to select theWSDL source.

For Enforce WS-I Basic Profile 1.1 compliance, select Yes or No. The default is No.

d. Provide a name for the service, select where to save the service, and click Next.

e. Click Finish.

Designer creates the provider web service descriptor and a flow service with the name,
notifications. The input and output signatures of this flow service will be defined.

2. Code the logic in the empty notifications flow service. You can add any custom code for further
processing.

Because Salesforce.com expects an acknowledgment to the outbound message that it sends,
the business logic should also include steps to map the output signature with the required
value.

Setting Up an Enterprise Gateway Server

This section provides the basic steps for setting up an Enterprise Gateway Server. For detailed
information, see the webMethods Integration Server Administrator’s Guide for your release.

To set up an Enterprise Gateway Server

1. Install an Integration Server in your DMZ to be your Enterprise Gateway Server.
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2. Disable the Integration Server "Developer" and "Replicator" users because you will not need
these users on an Enterprise Gateway Server. Disabling these users prevents someone from
gaining access to your Enterprise Gateway Server through them.

3. Set up the Enterprise Gateway external port tomake Integration Server an Enterprise Gateway
Server. The Enterprise Gateway external port is the port throughwhich the Enterprise Gateway
Server will listen for the requests from Salesforce.com.

The endpoint URL of the Salesforce.com outbound message must point to the Enterprise
Gateway external port of the Enterprise Gateway Server. Formore information, see “Updating
the Endpoint URL of the Salesforce.com Outbound Message” on page 141.

4. Set up the Enterprise Gateway registration port. Through this port the Enterprise Gateway
Server maintains its connection to the Internal Server and routes the outboundmessage to the
web service descriptor.

Create the connections from the Internal Server to the Enterprise Gateway Server. For more
information, see the webMethods Integration Server Administrator’s Guide for your release.

Updating the Endpoint URL of the Salesforce.com Outbound
Message

After setting up an Enterprise Gateway Server, you must update the endpoint URL specified in
the outbound message to point to the external port of the Enterprise Gateway Server.

To update the endpoint URL of the outbound message for Integration Server

1. In the Salesforce.com user interface, go to Setup > Create > Workflow & Approvals >
Outbound Messages.

2. Click Edit to make changes to an existing outbound message.

3. View theWSDLdocument onwhich theweb service descriptor is based. Formore information
about how to acquire a WSDL document for the provider web service descriptor, see the
webMethodsWeb Services Developer’s Guide.

The value of the address location element in the WSDL document currently specifies the
location of the web service descriptor.

4. Use the value of the address location element in the WSDL and replace the <IP>:<port> part
of this address with <Enterprise Gateway Server IP>:<Enterprise Gateway external port>
to create an endpoint URL for the outbound message.

When Salesforce.com sends an outbound message to this newly created endpoint URL, the
outbound message is routed through the Enterprise Gateway Server and reaches the web
service descriptor in the Internal Server.
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For more information about creating the web service descriptor for the outbound message
from Salesforce.com, see “Creating aWeb ServiceDescriptor in Integration Server for Receiving
the Outbound Message” on page 139.

5. In the Endpoint URL field, enter the endpoint URL for the outbound message (that is, the
endpoint URL you created in step 4).

For example, let us consider that the value of the address location element in the WSDL is
http://10.60.28.176:5555/ws/OutboundMessaging:testWSDLDescriptor, the IP address of the
Enterprise Gateway Server is 10.30.20.110, and the Enterprise Gateway external port is 7777.

If you replace 10.60.28.176:5555 with 10.30.20.110:7777 in the address, the resulting address
will be http://10.30.20.110:7777/ws/OutboundMessaging:testWSDLDescriptor

Then, youwill specify http://10.30.20.110:7777/ws/OutboundMessaging:testWSDLDescriptor
as the endpoint URL for the outbound message.

6. Click Save.

7. Formore information about configuring the outboundmessages, see the Force.comWeb Services
API Developer's Guide.
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Predefined Health Indicator

Microservices Runtime includes predefined health indicators for some of its basic components.
The health indicator captures the connection details for all theWmARTbased adapters at runtime.
For more information, see webMethods Adapter Runtime User's Guide.
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Administrator APIs

The Administrator APIs are available for Adapter for Salesforce. For more information about
Administrator APIs and samples, see webMethods Adapter Runtime User's Guide.
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Configuration Variables Templates for Adapter Assets in
Microservices Runtime

ThewebMethodsAdapter Runtime (ART) asset properties that can be configured from Integration
ServerAdministrator are available in the configuration variables template (application.properties
file) generated by Microservices Runtime. For more information, see webMethods Adapter Runtime
User's Guide and Developing Microservices with webMethods Microservices Runtime.
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Parallel Asset Initialization

webMethods Adapter Runtime assets, connections, listeners, and notifications are initialized
during Integration Servers startup and when packages are loaded. As a part of package loading,
the enabled connections connect with the external systems. The listeners and notifications are
initialized after the connections are initialized. The communication with external systems can be
erroneous due to multiple reasons, such as broken connectivity and others. The communication
with external systems also increases the time taken by the packages to load and subsequently
increases the Integration Servers startup time. To address this issue,webMethodsAdapter Runtime
supports parallel asset initialization. Formore information, seewebMethods Adapter RuntimeUser's
Guide.
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Overview

The following sections describe Adapter for Salesforce message logging, exception handling, and
error codes. A list of error codes and supporting information appears at the end of this chapter.

Adapter Logging Levels

Adapter for Salesforce uses the Integration Server logging mechanism to log messages. You can
configure and view the Integration Server logs tomonitor and troubleshoot Adapter for Salesforce.

For more information about logging in Integration Server, including instructions for configuring
and viewing the different kinds of logs supported by the server, see the webMethods Audit Logging
Guide for your release.

Configuring Adapter Logging Levels

To access the adapter's logging information and change logging settings

1. From Integration Server Administrator, select Settings > Logging.

On the Logging Settings screen, the Loggerssection has Adapters included in the Facility
section.

2. Expand theAdapters tree to see a list of all installed adapters with their code number and
adapter description, along with the logging level.

3. Select Edit Logging Settings.

4. Select the required Level of logging for Adapter for Salesforce.

5. After making your changes, click Save Changes.

6. For complete information about specifying the amount and type of information to include in
the log, see the webMethods Audit Logging Guide for your release.

Adapter for Salesforce Message Logging

Integration Servermaintains several types of logs. However, Adapter for Salesforce logsmessages
only to the audit, error, and server logs. Because Adapter for Salesforce works in conjunction with
theWmARTpackage, the adapter'smessages and exceptions typically appearwithin logmessages
for the WmART package.

The following table lists the logging levels supported by Integration Server for Adapter for
Salesforce:
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DescriptionLogIntegration Server

You can monitor individual adapter services
using the audit log as you would audit any

Audit LogIntegration Server 8.2 or
later

service in the Integration Server. The audit
properties for an adapter service are available in
the Adapter for Salesforce service template in
the Properties panel.

Adapter for Salesforce automatically posts
fatal-level and error-level log messages to the

Error Log

error log. These log messages will appear as
Adapter Runtime messages.

Adapter for Salesforce posts messages to the
server log, depending on how the server log is

Server Log

configured. Fatal-level through debug-level log
messages appear as Adapter Runtime log
messages. Trace-level log messages appear as
Adapter for Salesforce log messages.

Adapter for Salesforce's log messages appear in the following format: ADA.0505.nnnnc, where:

ADA is the facility code that indicates that the message is from an adapter.

0505 is the Adapter for Salesforce major code, which indicates that the error is generated
byAdapter for Salesforce.

nnnn represents the error's minor code.

c represents the message's severity level (optional).

Tomonitor the Adapter for Salesforce logmessages in the Server log, ensure that your server log's
logging settings are configured to monitor the following facilities:

0113 Adapter Runtime (Managed Object)

0114 Adapter Runtime

0117 Adapter Runtime (Adapter Service)

0118 Adapter Runtime (Connection)

0126 Adapter Runtime (System Contract Component [SCC] Connection Manager)

Adapter for Salesforce Exception Handling

Exceptions raised by the adapter will contain the SOAP fault errors that Salesforce.com returns
in its error stack.

The Force.comWeb services API calls provides the following types of error handling:
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For errors resulting from badly formed messages, failed authentication, or similar problems,
the Force.comWeb services API returns a SOAP fault message with an associated Exception
Code.

For most calls, if the error occurs because of a problem specific to the query, the API returns
an Error. For example, if a create request contains more than 200 objects, the API returns an
Error.

For more information about Salesforce.com error handling, see the Force.com Web Services API
Developer's Guide.

When creating a flow or Java service that incorporates an adapter service, youmight want to build
logic into the wrapping service to catch and handle exceptions.

Adapter Error Codes

This section lists the Adapter for Salesforce error codes and provides information on the message,
reason, and possible action for each error.

DescriptionError Code

Resource Connection Exception.1001

Explanation: This message is displayed either when there is an error while
connecting to Salesforce.com or when the login request encounters an API fault
with INVALID_SESSION_ID for the current user.

Action:No user intervention required. The adapter will automatically try to
reset the connection pool.

Register Resource Domain Exception.1002

Explanation: There is an error while trying to register the resource domains for
the adapter. This exception is due to the occurrence of an error either while
trying to create a new adapter service orwhile loading themetadata information
for any existing adapter service.

Action: If the exception occurs even after a retry, contact Software AG Global
Support.

Unable to describe global types. exception_message.1005

Explanation: The adapter is unable to get the list of available Salesforce objects.

Action: Ensure that the connection parameters are valid, and then retry the
operation.

Unable to describe sObject_list.exception_message.1006

Explanation: The adapter is unable to describe one or more Salesforce objects
requested in the describeSObjects() call.
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DescriptionError Code

Action: Ensure that the connection parameters are valid, and then retry the
operation.

Please be sure that you have a valid username and password.1007

Explanation: Incorrect username or password specified.

Action: The user should either use a different set of login credentials or use the
correct credentials.

Your password has expired.1010

Explanation: An expired password was used to log in to Salesforce.com. This
error can also occur when the adapter tries to log in again to keep the session
alive, but the password has expired.

Action: Specify a different set of login credentials or get the password renewed
by Salesforce.com.

API Fault occurredwhile executing the call [API_call_name], Code: exception_code,
Message: exception_message.

1011

Explanation: There is a fault in the indicated Force.com API Web service call.
The exception code and message thrown by the call are reported.

Action: Retry the call after making the appropriate changes as specified by the
API.

Unknown utility service: service_name.1012

Explanation: This error occurs while trying to execute a utility service that is
not implemented.

Action: This error indicates that an unknown utility API is trying to execute via
the indicated Utility Operation adapter service.

Contact Software AG Global Support, and report the error.

Error occurred while trying to get the resource domain values for service:
service_name and resource domain:domain_name.

1013

Explanation: Resource domain lookup failed for the indicated adapter service
and resource domain.

Action: Ensure that the connection parameters are valid, and then retry the
operation.

No output type description available for service service_name.1015

Explanation: Unknown or unhandled type description encountered for the
indicated adapter service.
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DescriptionError Code

Action: Contact Software AG Global Support, and report the error.

Service Exception thrown while executing the call [adapter_service_operation].1016

Explanation: Service exception thrown while executing the adapter service.

Action:Check the error logs formore information, and take the necessary action.

Remote Exception occurred during the execution of [adapter_service_operation].1017

Explanation:Remote exception thrownwhen an error occurswhile the indicated
adapter service is communicating with Salesforce.com.

Action:Check the error logs formore information, and take the necessary action.

Mandatory input missing.1018

Explanation: This error occurs when you do not specify the required input for
the adapter service.

Action: Rerun the adapter service and specify the required input.

Unable tomap the value [value] to type [data_type]. Message: exception_message.1019

Explanation:This error occurswhen the adapter tries tomap the indicated value
to a supported data type. The specific exception message is reported.

Action: Contact Software AG Global Support, and report the error.

InvalidArgument passed for the field [input_field] while invoking [web_service]
service.

1020

Explanation:This error occurswhen an invalid value is specified for the indicated
input field while invoking a Web service.

Action: Specify a correct value to the input field, and then retry the operation.

The library files required for enabling the compression functionality are
missing.

1021

Explanation: The jar files required by the adapter to enable compression in the
SOAP request and response messages are missing.

Action: See the instructions in “Configuring a Salesforce.com Connection” on
page 57.

Input parametermismatch. SOQLhas [num_?_characters] '?' character(variables)
and service input has [num_input_parameters] input parameters. To resolve this
error, configure [num_?_characters] input parameters.

1022

156 webMethods Adapter for Salesforce Installation and User’s Guide 8.2

13 Logging and Exception Handling



DescriptionError Code

Explanation: The CustomQuery Operation service has an SOQL query that has
a greater number of varsub parameters (? character) than the number of input
parameters.

Action:Make sure that the number of varsub parameters (? character) is the
same as the number of input parameters.

Max number of rows per batch should be greater than 0.1031

Explanation: The 'Max number of rows per batch' field of the Batch Operation
service has a value less than 1.

Action:Make sure that the 'Max number of rows per batch' field has a value
greater than 0.

SObject or operation type is missing for batch operation.1033

Explanation: The error occurs because either the 'Salesforce Object' field, the
'Salesforce Bulk Operations' field of the Batch Operation service, or both fields
are empty.

Action:Make sure that the 'Salesforce Object' and 'Salesforce Bulk Operations'
fields are populated correctly.

Invalid batch size [batch_size]. Using the default batch size [default_batch_size].1034

Explanation: An invalid batch size for sObjects was specified using the
watt.adapter.salesforce.sobjects.batchSize watt property. Therefore, the adapter
will use the default batch size of 100.

Action:Make sure that a valid batch size is specified using the
watt.adapter.salesforce.sobjects.batchSize property. Formore information about
the property, see “BeforeConfiguring orManagingAdapter Services” on page 70.

Invalid access token.1035

Explanation:AnOAuth loginwith Salesforce.comwasunsuccessful and returned
an empty access token.

Action:Make sure that the corresponding OAuth connection properties are
correct and valid. Also, verify the connectivity to the Salesforce.com backend.

Exception occurred during http.start. Message: [exception_message].1036

Explanation: An exception occurred during the initiation of the OAuth login
with Salesforce.com.

Action:Make sure that the corresponding OAuth connection properties are
correct and valid. Also, verify the connectivity to the Salesforce.com backend.
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DescriptionError Code

I/O exception occurred during the HTTP request/response. Message:
[io_exception_message].

1038

Explanation: An I/O exception occurred during the HTTP request/response
process for an OAuth connection login or during the setting of the connection’s
end-point URL.

Action:Make sure that the corresponding OAuth connection properties are
correct and valid. Also, verify the connectivity to the Salesforce.com backend.

Exception occurred during SOAP binding. Message: [exception_message].1039

Explanation:Anadapter connection exception occurredduring the SOAPbinding
of a connection with Salesforce.com.

Action:Make sure that the corresponding connection properties are correct and
valid. Also, verify the connectivity to the Salesforce.com backend.

External ID field not available for the object [SObject], which is mandatory
for an upsert operation.

1040

Explanation: This error occurs if the operation type in a Batch Operation is an
upsert operation and an external ID is not availablewhen the service is executed.

Action:Make sure that there is a valid external ID provided for the upsert
operation.

The day count must be an integer between 1 and 30.1050

Explanation:This error occurs if you specify an incorrect value for theDayCount
field while configuring an Upsert or Delete notification.

Action: Specify a value between 1 and 30.

The selected sObject is not replicable.1051

Explanation: This error occurs if you selected a non-replicable Salesforce object
while configuring an Upsert or Delete notification.

Action: Select the correct Salesforce object while configuring anUpsert or Delete
notification. For more information on replicable objects, see the Force.com Web
Services API Developer's Guide.

An sObject is mandatory.1052

Explanation: This error occurs while validating a notification that does not
specify which Salesforce object is to be monitored.

Action: Specify the Salesforce object to be monitored by the notification.

Unable to retrieve the start date for the notification.1053
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Explanation:This error occurswhile retrieving the start date from the persistence
store. The error can occur either due to a network issue or by corrupted data in
the persistence store. Depending on the version of Integration Server, the
persistence store could be the repository or the shared cache.

Action: Restart the notification after correcting the issue.

The push topic name selected in the notification is incorrect. Select the push
topic that is configured with the listener.

1054

Explanation:This error occurs if the push topic selected for a listener notification
does not match the push topic of the listener with which the listener notification
is configured.

Action:Make sure that the push topic for the listener notification is the same as
the one for the listener that is configured with the notification.

Unable to invoke pub.storage service service_name.1059

Explanation: This error occurs when the adapter tries to invoke the indicated
pub.storage service to save or retrieve data from the persistence store.

Action: Check the error logs for more details.

Exception occurred while enabling the listener. Handshake failed
[handshake_exception_message].

1060

Explanation: This error occurs in case of a problem during the handshake with
Salesforce.com while enabling a listener.

Action:Make sure that the listener is using a valid OAuth connection and the
listener properties are correct and valid. Also, verify the connectivity to the
Salesforce.com backend.

Exception occurredwhile enabling the listener. Initialization of BayeuxClient
failed [exception_message].

1061

Explanation: The listener creates a Bayeux Client during a handshake with
Salesforce.com. This error occurs in case of a problem initializing the Bayeux
Client or while the Bayeux Client subscribes to the push topic.

Action:Make sure that the listener is using a valid OAuth connection and the
listener properties are correct and valid. Also, verify the connectivity to the
Salesforce.com backend.

Exception occurred in Bayeux Client communication for the event [event].
Exception message [exception_message].

1062

Explanation: The issue occurs when amessage cannot be delivered successfully
to the Bayeux Client for an event that the client is monitoring.
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Action: Verify the connectivity to the Salesforce.com backend.

Use a Salesforce.comOAuth connection. Connection [connection] is not a valid
Salesforce.com OAuth connection.

1064

Explanation: The error occurs when you try to enable a listener that does not
use a Salesforce.com OAuth connection. A Adapter for Salesforce listener can
work only with an OAuth connection.

Action:Make sure that the listener uses a valid Salesforce.comOAuth connection.

The push topic [push_topic_name] configured in the listener is incorrect. No
such push topic exists for the selected connection.

1066

Explanation: The error occurs when you try to enable a listener, but you have
provided a push topic that does not exist for the Salesforce.comOAuth connection
configured with the listener.

Action:Make sure the push topic for the listener exists for the Salesforce.com
OAuth connection configured with the listener.

Invalid migration package: [package_name].2001

Explanation: The error occurs when you provide an invalid customAdapter for
Salesforce package as input to the migrate_711_To_82migration service.

Action:Make sure the custom package exists in Integration Server and is a valid
Adapter for Salesforce 7.1 SP1 package.

Either connection data node was not found or updating endPointURL failed
for connection: [connection_name].

2002

Explanation: The error occurs when the migrate_711_To_82migration service
encounters an old Salesforce.com 7.1 SP1 service that points to a non-existent
connection orwhen the connection could not be updatedwith the new end-point
URL.

Action:Make sure that the connections to which the Salesforce 7.1 SP1 services
refer, exist and are not in use.

Could not enable the connection: [connection_name].2003

Explanation: The error occurs when the migrate_711_To_82migration service can
not enable the connection associatedwith a Salesforce 7.1 SP1CREATE,UPDATE,
or UPSERT service. This is required to dynamically fetch the resource domain
values for these services and migrate them to the new Salesforce 8.2 standard.

Action:Make sure that the connection is a valid Salesforce.com connection and
its connection properties are correct. Try to enable the connectionmanually and
run the migration service again.
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Could not get resource domain values for node: [service_node_name].2004

Explanation: The error occurs when the migrate_711_To_82migration service can
not fetch the resource domain values for a Salesforce 7.1 SP1CREATE,UPDATE,
orUPSERT service. This is required tomigrate these services to the newSalesforce
8.2 standard.

Action:Make sure that the connection associated with the service is a valid
Salesforce.com connection and its connection properties are correct. Ensure that
the end-point URL points to partner jar version 25 and that the connection is
enabled.

Resource [SObject_name] not found in the resource domain values obtained
for node: [<<service_node_name>>].

2005

Explanation: The error occurs when the migrate_711_To_82migration service can
not find the old sObject name of a Salesforce 7.1 SP1 CREATE, UPDATE, or
UPSERT service in the newly obtained resource domain values.

Action:Make sure that the connection associated with the service is a valid
Salesforce.com connection and its connection properties are correct. Ensure that
the end-point URL points to partner jar version 25 and that the connection is
enabled.
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Overview

This appendix contains a description of Siebel Adapterparameters you can specify in the server
configuration file (server.cnf), which is located in the Integration Server_directory\configdirectory.
Typically you use the Settings > Extended screen in Integration Server Administratorto update
this file, but there might be times when you need to edit the file directly using a text editor. If you
edit the file directly, you should first shut down Integration Serverbefore updating the file. After
youmake the changes, restart the server. If you are using the Settings > Extended screen to update
the server configuration file (server.cnf), a server restart is not required unless otherwise specified.
The server uses default values for the parameters. If a parameter has a default, it is listed withthe
description of the parameter.
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